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RECALIBRATION
Your Alicat instrument is a precision device and Alicat strongly 
recommends that you send it to us on a yearly basis for recalibration. 

A yearly recalibration does a few things: 

 ► It insures that your unit is functioning according to speci� cation. 

 ► Contamination may cause the instrument to measure � ow 
improperly. Recalibration insures the instrument is clean and free 
from debris.

 ► Recalibration maintains your LIFETIME WARRANTY!

Sending your unit for recalibration is easy and inexpensive. Recalibrations 
are usually shipped within � ve days of receipt, so it’s fast too.

Please keep the original box to return your Alicat instrument for recalibration.

For more information regarding recalibration see page 45.

ACCESSORIES
Now that you have your Alicat instrument are you sure you’ve got 
everything you need? Alicat accessories can make your job easier.

Many of our customers also order:

 ► Power Supplies — A universal wall power supply that makes it easy 
to power your Alicat unit just about anywhere in the world.

 ► BB9 — Alicat’s multi-drop box that allows easy connection of up to 
nine Alicat instruments to a single USB, RS-232 or RS-485 port.

 ► MD8DB9 — An RS-232 to 8 pin Mini-DIN cable to connect your 
Alicat instrument to a computer. A variety of other cables are also 
available.

 ► Flow Vision™ SC — A GUI based Windows®program that allows easy 
computer access and control for one or multiple Alicat instruments.

 ► Fittings and � lters — Keep your instrument properly connected to 
your process and free from harmful contamination.

See  pages 48-51 for a complete description and list of Alicat accessories.

10/15/2014  Rev27                        DOC-PPC16MAN

See  pages 48-51 for a complete description and list of Alicat accessories

FULL TECHNICAL SUPPORT | LIFETIME WARRANTY
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Thank you for purchasing a P-Series Pressure Gauge or PC-Series Vacuum and 
Pressure Controller. Please take the time to find and read the information for your 
specific device. This manual covers the following Alicat Scientific instruments:

 P-Series Digital Pressure Gauge

 PC-Series Vacuum and Pressure Controllers

 PC3-Series Vacuum and Pressure Controllers

 PCR-Series High Flow Vacuum and Pressure Controllers 

 PCR3-Series Vacuum and Pressure Controllers

 PCD  and PCRD-Series Dual Valve Pressure Controllers

 PS, PCS, PCRS, PCDS and PCRDS-Series — instruments for use with 
aggressive gases (see page 61).

PC-EXTSEN Pressure Controllers — instruments for use with an  
end-user supplied external sensor (see pages 83-85).

This includes P, PC and PCR-Series devices labeled as approved for CSA Class 1 
Div 2 and ATEX Class 1 Zone 2 hazardous environments. See pages 86 and 87 for 
Special Conditions regarding the use of CSA/ATEX labeled devices.

The installation (plumbing, mounting and power/signal connection instructions are 
applicable to all P, PC (includes PC3), PCR (includes PCR3) and PCD-Series devices. 

Unless specifically noted, all instructions for PC-Series Controllers are 
applicable to PC3, PCR, PCR3, PCD and PCRD controllers as well.

 Alicat Portable Pressure Gauges

Note: Alicat Portable Pressure Gauges operate in accordance with the P-Series 
Pressure Gauge instructions found in this manual. Please see page 46 for 
information regarding battery replacement.

Please contact Alicat at 1-888-290-6060 or info@alicat.com if you have 
any questions regarding the use or operation of this device.
Many Alicat instruments are built for specific applications. Two 
instruments with the same flow range and part number may look and 
act quite differently depending upon the application the instrument was 
built for. Care should be taken when moving an instrument from one 
application to another.

You can find a number of instructional 
videos related to the operation of this 
device by visiting the Alicat web site or 
scanning the QR code.

http://www.alicat.com/support/instructional-videos/
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GETTING STARTED
8 Pin Mini-DIN

Display Screen
Inlet Connection Port

Outlet Connection Port 
shown with Plug

Power Jack

P-Series Pressure Gauge

Control Valve

Inlet Connection Port

Flow Direction Arrow

Outlet Connection Port

PRESS
PSIA

PC-Series Pressure Controller Shown with Standard Upstream Valve

Inlet Connection Port Outlet Connection Port

PCR-Series Pressure Controller

Control Valve
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MOUNTING
All P-Series Gauges and PC-Series Controllers have mounting holes for 
convenient mounting to flat panels. These gauges are position insensitive and 
can be mounted in any orientation. The sizes and dimensions for the mounting 
holes are shown on pages 52 to 67.
P-Series Pressure Gauges may be connected into your system with the flow 
going in either direction for ease of viewing the display. These units are shipped 
with a plug for dead end applications. This plug should be removed for flow 
through applications.
PC-Series Vacuum and Pressure Controllers are normally intended to control 
the process pressure downstream of the controller. In order for this to occur the 
controller should be mounted so the flow goes from left to right as you look at 
the front of the unit. This puts the measuring portion of the device between the 
valve and the leakage point where you are attempting to control the pressure 
application. Back-pressure controllers reverse this configuration (see page 30).

PLUMBING
Your instrument is shipped with plastic plugs fitted in the port openings. 
To lessen the chance of contaminating the flow stream do not remove 
these plugs until you are ready to install the device.
Make sure that flow is in the direction indicated by the flow arrow.

Standard P-Series Gauges and PC-Series Controllers have female inlet and outlet 
port connections. Welded VCR and other specialty fittings may have male ports.
The inlet and outlet port sizes (process connections) for different flow ranges 
are shown on pages 52-67.
Instruments with M5 (10-32) ports have O-ring face seals and require no 
sealant or tape. Do not use tape with welded or O-ring fittings.
For non M5 (10-32) ports use thread sealing Teflon® tape to prevent leakage 
around the port threads. 
Do not wrap the first two threads. This will minimize the possibility of getting 
tape into the flow stream and flow body. 

Do not use pipe dopes or sealants on the process connections as these 
compounds can cause permanent damage to the controller should they get 
into the flow stream.

When changing fittings, carefully clean any tape or debris from the port threads.

For additional notes on PCD (dual valve controller) plumbing see page 33.
For gas applications, it is recommended that a 40 micron filter be installed 
upstream of P and PCR-Series instruments and a 20 micron filter be installed 
upstream of PC and PCD-Series instruments. 
For liquid applications, see “Using Alicat Pressure Instruments with Fluids”, page 8.

Connecting Fittings and Filters 
http://www.alicat.com/support/instructional-videos/
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USING ALICAT PRESSURE INSTRUMENTS WITH FLUIDS

All of these devices may by used with chemically compati ble liquids providing a 
couple of things are taken into account:

1. Water is about 50 ti mes more viscous than air. This is important when 
sizing a pressure controller. The PC-Series which can be used to fl ow up 
to 20 SLPM of gas, will be limited to roughly 0.5 LPM of water-like fl uid. 
The PCR will be limited to roughly 30 LPM of water-like fl uid.

2. The factory PID tune is established using air fl ow. It may be necessary 
to adjust the PID tuning parameters if you will be using a controller 
with liquids.

SPECIAL CONFIGURATIONS

P, PC, and PCR-Series pressure devices are occasionally ordered with special 
confi gurati ons which are covered here:

1. External Sense Port: Occasionally it is necessary or desirable to sense 
the pressure at some point other than at the locati on of the pressure 
device. All P, PC, or PCR-Series pressure devices can be ordered with 
an additi onal NPT port which is connected directly with the pressure 
sensor of the device. In these devices the fl ow path through the device 
is NOT connected to the pressure sensor. See  “PC3-Series Pressure 
Controllers” – page 30.

2. Diff erenti al Pressure: Occasionally it is necessary or desirable to 
monitor or control a diff erenti al pressure. P, PC, and PCR-Series 
pressure devices can be ordered as low diff erenti al pressure devices 
(usually 1 to 5 psid). These devices have two ports located on the front 
face of the unit for connecti on to the points in the system where the 
diff erenti al pressure is to be measured. The upstream port is for the 
higher pressure and the downstream port is for the lower pressure. In 
these devices the fl ow path through the device is NOT connected to 
either leg of the diff erenti al pressure sensor. See “Diff erenti al Pressure 
Gauges and Diff erenti al Pressure Controllers” – pages 32 & 33.

PC-EXTSEN units connect a Pressure Controller (with no internal pressure 
sensor) to an end-user supplied external pressure sensor. Designed mainly 
for the vacuum coati ng industry, the PC-EXTSEN marries the sensing ability of 
an existi ng capacitance manometer or ion gauge with a 16-Series electronics 
package and internal PID algorithm. This enables fast and precise control of 
extreme vacuum conditi ons in the coati ng chamber. See pages 83-85.

CAUTION!  E�ceeding the ma�imum speci�ied �ine pressure ma� 
cause permanent damage to the so�id-state di��erentia� pressure 
transducer.
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POWER AND SIGNAL CONNECTIONS
Power can be supplied to your gauge/controller through either the power jack or 
the 8 pin Mini-DIN connector. 
An AC to DC adapter which converts line AC power to DC voltage and current as 
specified below is required to use the power jack. 
A 2.1mm, positive center, 7-30 Vdc AC/DC adapter rated for at least 100 mA is 
required to use the adapter jack in a P-Series meter.
A 2.1mm, positive center, 12-30 Vdc AC/DC adapter rated for at least 250 mA is 
required to use the adapter jack in a PC-Series controller. 
A 2.1mm, positive center, 24-30 Vdc AC/DC adapter rated for at least 500 mA is 
required to use the adapter jack in a PCR-Series controller.
NOTE: 4-20mA analog output requires at least 15 Vdc.

CAUTION! Do not connect power to pins 1 through 6 as permanent damage can occur!

It is common to mistake Pin 2 (labeled 5.12 Vdc Output) as the standard 0-5 Vdc 
analog output signal. In fact Pin 2 is normally a constant 5.12 Vdc that reflects the 
system bus voltage and can be used as a source for the set-point signal.
For 6 Pin Locking Connector, DB9 and DB15 Pin-outs see pages 70 to 82. 
For PROFIBUS Pin-outs see page 68.

Standard 8 Pin Mini-DIN Pin-Out



 







1 2

3 4 5

6 7 8

Pin Function Mini-DIN 
cable color

1 Not Connected (or optional 4-20mA Primary Output Signal) Black

2 Static 5.12 Vdc [or optional Secondary Analog Output (4-20mA, 
5Vdc, 10Vdc) or Basic Alarm] Brown

3 Serial RS-232RX / RS-485(–) Input Signal (receive) Red

4 Meters/Gauges = Remote Tare (Ground to Tare)
Controllers = Analog Set-Point Input Orange

5 Serial RS-232TX  / RS-485(+) Output Signal (send) Yellow
6 0-5 Vdc (or optional 0-10 Vdc) Output Signal Green
7 Power In (as described above) Blue
8 Ground (common for power, communications and analog signals) Purple

Note: The above pin-out is applicable to all the flow meters and controllers with the 
Mini-DIN connector. The availability of different output signals depends on the options 
ordered. Optional configurations are noted on the unit’s calibration sheet.

Electrical Connections and Basic Wiring
http://www.alicat.com/support/instructional-videos/
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INPUT SIGNALS
Analog Input Signal
Apply analog input to Pin 4 as shown on page 9.
For 6 Pin Locking Connector, DB9 and DB15 Pin-outs see pages 70 to 82. 
For PROFIBUS Pin-outs see page 68.
Standard 0-5 Vdc is the standard analog input signal. Apply the 0-5 Vdc input 
signal to pin 4, with common ground on pin 8. 
Opti onal 0-10 Vdc: If specifi ed at ti me of order, a 0-10 Vdc input signal can be 
applied to pin 4, with common ground on pin 8.
Opti onal 4-20 mA: If specifi ed at ti me of order, a 4-20 mA input signal can be 
applied to pin 4, with common ground on pin 8. 
NOTE: This is a current sinking device. The receiving circuit is essenti ally a 250 
ohm resistor to ground.  
NOTE: 4-20mA output requires at least 15 Vdc power input.

CAUTION!  Do not connect this de�ice to “�oop powered’” 
s�stems, as this wi�� destro� portions o� the circuitr� and �oid 
the warrant�. I� �ou must inter�ace with e�isting �oop powered 
s�stems, a�wa�s use a signa� iso�ator and a separate power supp��.

Gauges: A remote tare can be achieved by momentarily grounding pin 4 to tare. 

 

7 6

5 4 3

2 1

8

5.12 Vdc

50 KOhm 
Potentiometer

0-5 Vdc

Controllers: A simple method for providing set-point to controllers

4

8
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RS-232 / RS-485 Digital Input Signal

To use the RS-232 or RS-485 input signal, connect the RS-232 / RS-485 Output 
Signal (Pin 5), the RS-232 / RS-485 Input Signal (Pin 3), and Ground (Pin 8) to 
your computer serial port as shown below. (See page 35 for details on accessing 
RS-232 / RS-485 input.)













9 8 7 6



9876

15 3 24 1 532 4

Serial Cable End PC Serial Port



 









 











1

8 7 6

5

4

3

2

8 Pin MiniDIN Cable End 8 Pin MiniDIN Connector

9 Pin Serial Connection 8 Pin MiniDIN Connection
Pin Function Function Pin
5 Ground Ground 8
3 Transmit Receive 3
2 Receive Transmit 5

DB9 to Mini-DIN Connection for RS-232 / RS-485 Signals
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OUTPUT SIGNALS

RS-232 / RS-485 Digital Output Signal

To use the RS-232 or RS-485 output signal, it is necessary to connect the RS-232 
/ RS-485 Output Signal (Pin 5), the RS-232 / RS-485 Input Signal (Pin 3), and 
Ground (Pin 8) to your computer serial port as shown on page 8. (See page 35 
for details on accessing RS-232 / RS-485 output.)

Standard Voltage (0-5 Vdc) Output Signal

Gauges/controllers equipped with a 0-5 Vdc (opti onal 0-10 Vdc) will have this 
output signal available on Pin 6. This output is generally available in additi on to 
other opti onally ordered outputs. This voltage is usually in the range of 0.010 
Vdc for zero fl ow and 5.0 Vdc for full-scale fl ow. The output voltage is linear 
over the enti re range. Ground for this signal is common on Pin 8.

Opti onal 0-10 Vdc Output Signal

If your gauge/controllerwas ordered with a 0-10 Vdc output signal, it will be 
available on Pin 6. (See the Calibrati on Data Sheet that shipped with your device 
to determine which output signals were ordered.) This voltage is usually in the 
range of 0.010 Vdc for zero fl ow and 10.0 Vdc for full-scale fl ow. The output 
voltage is linear over the enti re range. Ground for this signal is common on Pin 8.

Opti onal Current (4-20 mA) Output Signal

If your gauge/controllerwas ordered with a 4-20 mA current output signal, it will 
be available on Pin 1. (See the Calibrati on Data Sheet that shipped with your 
device to determine which output signals were ordered.) The current signal is 
4 mA at 0 fl ow and 20 mA at the device’s full scale fl ow. The output current is 
linear over the enti re range. Ground for this signal is common on Pin 8. (Current 
output units require 15-30Vdc power.)

Opti onal 2nd Analog Output Signal

You may specify an opti onal 2nd analog output on Pin 2 at ti me of order. (See 
the Calibrati on Data Sheet that shipped with your device to determine which 
output signals were ordered.) This output may be a 0-5 Vdc, 0-10 Vdc, or 
4-20 mA analog signal that can represent any measured parameter. With this 
opti onal output, a meter could output the volume fl ow rate (0-5 Vdc on pin 6) 
and the line temperature (0-5 Vdc on pin 2). 

If your device is CSA/ATEX approved or equipped with the opti onal six pin 
industrial connector, please contact Alicat.

CAUTION!  Do not connect this de�ice to “�oop powered’” 
s�stems, as this wi�� destro� portions o� the circuitr� and �oid 
the warrant�. I� �ou must inter�ace with e�isting �oop powered 
s�stems, a�wa�s use a signa� iso�ator and a separate power supp��.
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Typical Multi ple Device (Addressable) Wiring Confi gurati on

The easiest way to connect multi ple devices is with a Multi -Drop Box 
(see page 48).

CAUTION!  Do not connect this de�ice to “�oop powered’” 
s�stems, as this wi�� destro� portions o� the circuitr� and �oid 
the warrant�. I� �ou must inter�ace with e�isting �oop powered 
s�stems, a�wa�s use a signa� iso�ator and a separate power supp��.

5
3

2

Purple

Red
Yellow

Purple

Red
Yellow

5 4 3 2 1

9
8 7

6

Unit C

Unit B

Unit A

Female Serial Cable Front

Purple (Ground)

Red
Yellow
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Information for Alicat TFT (Color Display) Instruments
Alicat TFT (color display) instruments have a high contrast back-lit LCD display. 
TFT instruments operate in accordance with Alicat standard operating instructions 
for our monochrome menus and displays with the following differences. 

Multi-Color Display Color Codes:

GREEN: Green labels identify the parameters and/or adjustments 
associated with the button directly above or below the label.

WHITE: The color of each parameter is displayed in white while operating 
under normal conditions.

RED: The color of a parameter is displayed in red when operating 
conditions for that parameter exceed 128% of the device’s specifications.

YELLOW: Yellow is the equivalent of the selection arrow on the 
monochrome display.

LCD Contrast: 
LCD contrast is ranged from 1 to 11 on color displays with 11 being the greatest 
contrast.

Display On/Off: 
Pushing the button under the Alicat name will turn the device display on or off. 
This feature is not available on monochrome displays.

Technical Data for TFT (Color Display) Meters, Gauges and Controllers

The following specifications are applicable to Alicat TFT (color display) meters, 
gauges and controllers only. All other operating specifications are shown in the 
Technical Data page for standard Alicat instruments. All standard device features 
and functions are available and operate in accordance with the Alicat operating 
manual provided with the device. 

Specification Meter  or 
Gauge

Small Valve 
Controller

Large Valve 
Controller

Supply Voltage 7 to 30 Vdc 12 to 30 Vdc 24 to 30 Vdc
Supply Current 80 mA @ 12Vdc

70 mA @ 24Vdc
290 mA @ 12Vdc
200 mA @ 24Vdc

780 mA @ 
24Vdc



15

The Main display shows the pressure in 
the units specified at time of order.
By hitting the MENU button at the 
bottom right of the screen you will 
enter the Select Menu display.

DISPLAYS AND MENUS P-Series GAUGES
(Displays and Menus for PC and PCR Controllers are shown beginning page 22.)

The device screen defaults to Main display as soon as power is applied to the meter.

Select Menu
From Select Menu you can interact 
with your RS-232 / RS-485 settings 
or read manufacturer’s data. 
Push MAIN to return to the Main display.

RS232 
COMM

MFG
DATA

MAIN

MISC

Select Menu

MENU

TARE V 

PRESS
PSIG

PSIG
+13.60

+   .

Main

Note: P-Series Pressure Gauges may also be ordered as portable devices as 
described on page 46.
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MAIN 
This mode defaults on power up, with 
fl ow as the primary displayed parameter. 
The following parameters are displayed in 
the Main mode.
Line Pressure shows the pressure in the 
units specifi ed at ti me of order.

Tare: Pushing the TARE P butt on tares 
the pressure gauge and provides it with a 
reference point for zero pressure. 

This is an important step in obtaining 
accurate measurements. It is best to 
zero the pressure gauge each ti me it is 

powered up. If the pressure reading varies signifi cantly from zero aft er an initi al 
tare, give the unit a minute or so to warm up and re-zero it.

If in doubt about whether the pressure is zero, remove the gauge from the 
line and open both ports to atmosphere before entering the Tare command. 
For liquid pressure devices, all liquid must be drained from the gauge and any 
plumbing between the gauge and the atmosphere.

If the unit reads signifi cantly diff erent than zero when it is exposed to 
atmospheric pressure, it is a good indicati on that it was given a false tare.

MENU: Pressing MENU switches the screen to the Select Menu display.

MENU

TARE P

PRESS
PSIG

PSIG
+13.60

+   .

Flashing Error Message: An error message (POV = pressure 
overrange) fl ashes when pressure exceeds the range of the sensor. 
When any item fl ashes, the pressure measurement is not accurate. 

Reducing the pressure to within specifi ed limits will return the unit to normal 
operati on and accuracy. 

If the unit does not return to normal operati on contact Alicat.

Do Not Att empt To Tare Absolute Pressure (psia) Instruments!
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RS232 
COMM

MFG
DATA

MAIN

MISC

SELECT MENU
From Select Menu you can interact with your RS-232 / RS-485 settings or read 
manufacturer’s data.
Press the button next to the desired operation to bring that function to the screen.

Miscellaneous
Communication Select

Main

Manufacturer Data

An explanation for each screen can be found on the following pages.

MAIN

TARE P

PRESS
PSIG

PSIG
+13.60

+   .

MODEL
INFO

BACK MAIN1

A L I C A T  S C I E N T I F I C

Ph    520-290-6060

Fax  520-290-0109
MISC2

BACK MAIN

MISC1

BACK MAIN

UNIT ID
A

BAUD
19200

Select Menu
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COMMUNICATION SELECT
Access Communication Select by pressing 
the button above RS232 COMM or RS485 
COMM on the Select Menu display. 
Unit ID – Valid unit identifiers are the 
letters A-Z and @. The identifier allows 
you to assign a unique address to each 
device so that multiple units can be 
connected to a single RS-232 or RS-485 
computer port. 
Press UNIT ID. Use the UP and DOWN 
buttons to change the Unit ID. Press SET to 
record the ID. Press Reset to return to the 
previously recorded Unit ID.
Any Unit ID change will take effect when 
Communication Select is exited.
If the symbol @ is selected as the Unit 
ID, the device will enter streaming mode 
when Communication Select is exited. 
See RS-232 Communications (page 37) for 
information about the streaming mode.
Baud – Both this instrument and your 
computer must send/receive data at the 
same baud rate. The default baud rate for 
this device is 19200 baud. 
Press the Select button until the arrow is 
in front of Baud. Use the UP and DOWN 
buttons  to select the baud rate that 
matches your computer. The choices are 
38400, 19200, 9600, or 2400 baud. 
Any baud rate change will not take effect 
until power to the unit is cycled.

UP

BACK RESET A SET

UNIT ID
C

DOWN

DOWN

BACK SET

BAUD UP

19200

BACK MAIN

UNIT ID
A

BAUD
19200

C
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MISCELLANEOUS 
Miscellaneous is accessed by pressing the MISC button on the Select Menu display. 
Next select either MISC1 or MISC2. 

MISC1 will display as shown at left.
ZERO BAND refers to Display Zero Deadband. 
Zero deadband is a value below which the display 
jumps to zero. This deadband is often desired to 
prevent electrical noise from showing up on the 
display as minor flows or pressures that do not 
exist. Display Zero Deadband does not affect the 
analog or digital signal outputs.
ZERO BAND can be adjusted between 0 and 
3.2% of the sensor’s Full Scale (FS). 
Press ZERO BAND. Then use SELECT to choose 
the digit with the arrow and the UP and DOWN 
buttons to change the value. Press SET to record 
your value. Press CLEAR to return to zero.
Pressure Averaging and Flow Averaging may 
be useful to make it easier to read and interpret 
rapidly fluctuating pressures and flows. Pressure 
and flow averaging can be adjusted between 1 
(no averaging) and 256 (maximum averaging). 
These are geometric running averages where 
the number between 1 and 256 can be 
considered roughly equivalent to the response 
time constant in milliseconds. 

This can be effective at “smoothing” high frequency process oscillations such as 
those caused by diaphragm pumps. 
Press PRESS AVG. Then use SELECT to choose the digit with the arrow and the UP and 
DOWN buttons to change the value. Press SET to record your value. Press CLEAR to 
return to zero.

Press FLOW AVG. Then use SELECT to choose the 
digit with the arrow and the UP and DOWN buttons 
to change the value. Press SET to record your value. 
Press CLEAR to return to zero.
Setting a higher number will equal a smoother 
display. 
LCD CONTRAST: The display contrast can be 
adjusted between 0 and 30, with zero being the 
lightest and 30 being the darkest. Use the UP 
and DOWN buttons to adjust the contrast. Press 
SET when you are satisfied. Press CANCEL to 
return to the MISC display.

PRESS
AVG

BACK

LCD

CONTRAST MAIN

ZERO
BAND

FLOW
AVG

DOWN

CANCEL CLEAR SET

UP SELECT

0.0

>

DOWN

CANCEL RESET SET

UP

11
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MISC2 will display as shown at left. 
Press ROTATE DISP and SET to Inverted 180° 
if your device is inverted. The display and 
buttons will rotate together.DIAG

TEST

BACK MAIN

ROTATE 
DISP

BACK MAIN

SCROLL
R8:     AP Sig 7871
R9:     Temp Sig 39071
R10:    DP Side 9986
R11:     DP Brdg 36673
R13:    AP Brdg 36673
R16:    Meter Fun 199
R18:    Power Up 32768

DIAG TEST: This diagnostic screen displays 
the initial register values configured by the 
factory, which is useful for noting factory 
settings prior to making any changes. It is 
also helpful for troubleshooting with Alicat 
customer service personnel.
Select the DIAG TEST button from the MISC2 
screen to view a list of select register values. 
Pressing the SCROLL button will cycle the 
display through the register screens. An 
example screen is shown at left.
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MANUFACTURER DATA
Manufacturer Data is accessed by pressing 
the MFG DATA button on the Select Menu 
display. 

The initial display shows the name and 
telephone number of the manufacturer.

Press MODEL INFO to show important 
information about your flow device 
including the model number, serial 
number, and date of manufacture. 

Press BACK to return to the MFG DATA 
display.

Push MAIN to return to the Main display.

MODEL
INFO

BACK MAIN

A L I C A T  S C I E N T I F I C

Ph    520-290-6060

Fax  520-290-0109

BACK MAIN

MODEL:   PC-10SIG-D
SERIAL  NO:   110003
DATE  MFG:     10/7/2014
DATE  CAL:     10/9/2014
CAL  BY:   DL
SW REV:   5v00
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The Main display shows, temperature 
and volume flow. Line pressure will be 
also be displayed if the meter was order 
with this option.
Pressing the button adjacent to a 
parameter will make that parameter 
the primary display unit.
By hitting the MENU button at the 
bottom right of the screen you will 
enter the Select Menu display. 

DISPLAYS AND MENUS PC AND PCR CONTROLLERS
(Displays and Menus for P Gauges are shown beginning page 15.)

The device screen defaults to Main display as soon as power is applied to the controller.

Select Menu
From Select Menu you can interact 
with your RS-232 / RS-485 settings, 
read manufacturer’s data or access 
the control set-up display. 
Push MAIN to return to the Main display.

CONTROL
SETUP

RS232 
COMM

MFG
DATA

MAIN

MISC

Select Menu

MENU

SETPT
0.000  

PRESS
PSIA

PSIA
+13.60

+   .

Main
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MAIN 
This mode defaults on power up, with fl ow 
as the primary displayed parameter. 
The following parameters are displayed in 
the Main mode.
Line Pressure shows the pressure in the 
units specifi ed at ti me of order.
Set Point: The set-point (SETPT)is shown 
in the upper right of the display. 
For informati on on changing the set-point 
see SETPT SOURCE, page 25.
MENU: Pressing MENU switches the 
screen to the Select Menu display.

MENU

SETPT
0.000  

PRESS
PSIG

PSIG
+13.60

+   .

Flashing Error Message: An error message (POV = pressure 
overrange) fl ashes when pressure exceeds the range of the sensor. 
When any item fl ashes, the pressure measurement is not accurate. 

Reducing the pressure to within specifi ed limits will return the unit to normal 
operati on and accuracy. 

If the unit does not return to normal operati on contact Alicat.
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CONTROL
SETUP

RS232 
COMM

MFG
DATA

MAIN

MISC

SELECT MENU
From Select Menu you can change the selected gas, interact with your 
RS-232 / RS-485 settings, read manufacturer’s data and access the control 
setup screen.
Press the button next to the desired operation to bring that function to the screen.

Miscellaneous
Communication Select

Control Setup

Main

Manufacturer Data

An explanation for each screen can be found on the following pages:
Control Setup: Please see page 25.

Communication Select: Please see page 18.

Miscellaneous: Please see page 19.

Manufacturer Data: Please see page 21.

MAIN

SETPT
0.000  

PRESS
PSIG

PSIG
+13.60

+   .

MODEL
INFO

BACK MAIN

A L I C A T  S C I E N T I F I C

Ph    520-290-6060

Fax  520-290-0109

LOOP
VAR

OFF
AUTO PID MAIN

SETPT
SOURCE

MISC2

BACK MAIN

MISC1

BACK MAIN

UNIT ID
A

BAUD
19200

SETPT
+0.00  

Select Menu
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CONTROL SETUP 
Control Setup is accessed by pressing the button below Control Setup on the 
Select Menu display. From this screen you can select your set-point source, 
choose a loop variable and adjust the PID terms.

Press BACK to return to the Select Menu 
display. 
Press MAIN to return to the MAIN display
SETPT SOURCE – Pressing the button 
above SETPT SOURCE will allow you to 
select how the set point will be conveyed 
to your controller. 
Use the line-up and line-down buttons 
to move the arrow in front of the desired 
option. Then press SET.
Press CANCEL to return to the previous 
display. 
The controller will ignore any set-point 

except that of the selected set-point source and it will remember which input is 
selected even if the power is disconnected.

RS-232 (or RS-485) refers to a remote 
digital RS-232 / RS-485 set-point applied 
via a serial connection to a computer or 
PLC as described in the installation and 
RS-232 / RS-485 sections of this manual. 

Front Panel refers to a set-point applied 
directly at the controller. 

Front Panel input must be selected 
prior to changing the set-point at 
the device. 

Analog refers to a remote analog set-
point applied to Pin 4 of the Mini-DIN 
connector as described in the installation 

section of this manual. The standard analog input is 0-5 Vdc. 
To determine what type of analog set-point your controller has, refer to 
the Calibration Data Sheet that was included with your controller. 

If nothing is connected to Pin 4, and the controller is set for analog control, the 
device will generate random set-point values. 
NOTE: If your controller has the IPC (Integrated Potentiometer Control) option, 
the IPC dial will operate with the ANALOG set-point source selected.

SETPT refers to the set-point. This parameter may be changed using the display 
only if FRONT PANEL is selected as the Input. Press SETPT. Then use SELECT to 
choose the decimal with the arrow and the UP and DOWN buttons to change 
the value. Press SET to record your value. Press CLEAR to return to zero.

DOWN

CANCEL SET

UP MODE

 >RS232
   FRONT PANEL
   ANALOG

LOOP
VAR

ON
AUTO PID MAIN

SETPT
SOURCE

SETPT
+0.0
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CAUTION!  Ne�er �ea�e a Contro��er with a non-�ero set-point i� 
no pressure is a�ai�a��e to ma�e ��ow. The contro��er wi�� app�� 
�u�� power to the �a��e in an attempt to reach the set-point. 
When there is no ��ow, this can ma�e the �a��e �er� HOT!

CONTROL SETUP (conti nued)
LOOP VAR—Pressure controllers are 
defaulted to pressure. 
Pressure means that the controller is 
“closing the loop” on the pressure. This 
means that when you give the controller 
a set-point, the controller compares 
that set-point to the measured pressure 
and adjusts the valve to try to make the 
pressure and the set-point match. For the 
pressure, the input signal (e.g. 0-5 Vdc) 
corresponds to the full-scale pressure for 
the device.

LOOP
VAR

OFF
AUTO PID MAIN

SETPT
SOURCE

DOWN

CANCEL SET

UP MODE

 >  Pressure
   

SETPT
+0.0
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LOOP
VAR

OFF
AUTO PID MAIN

SETPT
SOURCE

CONTROL SETUP (conti nued)

Tareing (or zeroing) a gauge pressure or 
diff erenti al pressure controller provides it 
with a reference point for zero pressure. 

OFF AUTO / ON AUTO—this feature allows 
you to tare the controller.

The controller must be left  in the default 
OFF AUTO mode except when actually 
tareing the controller as explained below. 

It is, however, very important to perform 
this adjustment only when you are 
certain that the process ports are open to 
atmosphere and that there is No Flow! 

For liquid pressure devices, all liquid must be drained from the system. 
To correctly tare a gauge pressure or diff erenti al pressure controller:

1. Be sure the unit is in the OFF AUTO default setti  ng.
2. Disconnect all plumbing and make sure there is No Flow.
3. Push the butt on below OFF AUTO once so that the display reads ON AUTO.
4. Enter a Set-Point of ZERO. A zero set-point results in the closing of the valve 
and a known “no fl ow” conditi on.
5. Wait at least 30 seconds.
6. Push the butt on below ON AUTO once so that the display reads OFF AUTO.
7. Reconnect the plumbing.

If the unit reads signifi cantly diff erent than zero, when removed from 
the line and open, it is a good indicati on that it was given a false zero.

If your pressure controller was ordered with the opti onal “Tare-P”, you 
may tare it following the instructi ons for tareing a pressure gauge on 
page 16

Do Not Att empt To Tare Absolute Pressure (psia) Instruments!
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PID TUNING

PID Values determine the performance 
and operation of your proportional 
control valve. These terms dictate control 
speed, control stability, overshoot and 
oscillation. All units leave the factory with 
a generic tuning designed to handle most 
applications. If you encounter issues with 
valve stability, oscillation or speed, fine 
tuning these parameters may resolve the 
problem.
Alicat controllers allow you to adjust the 
Proportional, Integral and Differential 
terms of the PID control loop. 
To change the PID loop parameters, push 
the button below PID.
Press LOOP TYPE. Then use the UP and 
DOWN buttons to select the appropriate 
PID control algorithm. Press SET.
See the following page for descriptions 
of the PID Loop Types (PID Control 
Algorithms).

P refers to the Proportional term of the 
PID loop. 
I refers to the Integral term of the PID loop. 
D refers to the Differential term of the 
PID loop. 
Press P, I or D. Then use SELECT to choose 
the decimal with the arrow and the UP 
and DOWN buttons to change the value. 
Press SET to record your value. Press 
CLEAR to return to zero.

Before changing the P, I or D 
parameter, please record the initial 
value so that it can be returned to 

the factory setting if necessary.
Valve tuning can be complex. If you 
would like assistance, please contact 
Alicat for technical support.

I
00000

BACK
LOOP
TYPE MAIN

P
00100

D
02501

DOWN

CANCEL SET

UP MODE

 >PD PID
   PD2I PID

LOOP
VAR

ON
AUTO PID MAIN

SETPT
SOURCE

SETPT
+0.0

Overview of PID Adjustment on Alicat MFCs and Pressure Controllers
http://www.alicat.com/support/instructional-videos/
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The PD algorithm is the PID algorithm used on most Alicat controllers.
It is divided into two segments:
The first compares the process value to the set-point to generate a proportional 
error. The proportional error is multiplied by the ‘P’ gain, with the result added 
to the output drive register. 
The second operates on the present process value minus the process value during 
the immediately previous evaluation cycle. This ‘velocity’ term in multiplied by 
the ‘D’ gain, with the result subtracted from the output drive register. 
The above additions to and subtractions from the output drive register 
are carried over from process cycle to process cycle, thus performing the 
integration function automatically. 
Increasing the ‘P’ gain will promote the tendency of the system to overshoot, 
ring, or oscillate. 
Increasing the ‘D’ gain will reduce the tendency of the system to overshoot. 
The PD2I algorithm is a PID algorithm used primarily for high performance 
pressure and flow control applications. 
It exhibits two basic differences from the PD algorithm that most controllers utilize.

1. Instead of applying a damping function based upon the rate of change of the 
process value, it applies a damping function based upon the square of the rate of 
change of the process value.
2. The damping function is applied directly to the proportional error term 
before that term is used in the proportional and integral functions of the 
algorithm. This provides a certain amount of ‘look ahead’ capability in the 
control loop.

Because of these differences, you will note the following:
1. Increasing ‘P’ gain can be used to damp out overshoot and slow oscillations 
in pressure controllers. You will know that ‘P’ gain is too high, when the 
controller breaks into fast oscillations on step changes in set-point. On flow 
controllers, too high a ‘P’ gain results in slower response times. Too low a ‘P’ 
gain results in overshoot and/or slow oscillation. A good starting value for ‘P’ 
gain is 200.
2. If the unit was originally shipped with the PD2I algorithm selected, the 
‘D’ gain value should be left at or near the factory setting because it relates 
primarily to the system phase lags. If you are changing from the default 
algorithm to the PD2I algorithm, you should start with a ‘D’ gain value of 20.
3. The ‘I’ gain is used to control the rate at which the process converges 
to the set-point, after the initial step change. Too low a value for ‘I’ gain 
shows up as a process value that jumps to near the set-point and then takes 
awhile to converge the rest of the way. Too high a value for ‘I’ gain results in 
oscillation. A good starting value for the ‘I’ gain is 200.
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FLOW

Alicat Precision 
Pressure Controller

Pressure Control Application, Upstream Valve

Back Pressure Control Application, Downstream Valve (DS)
Specify DS in part number adder code

Mechanical 
Pressure 
Regulator

Mechanical 
Pressure 
Regulator

Vent Flow

FLOW

Alicat Precision 
Pressure Controller

Process

Process
Flow Exiting
Bleed Port

Upstream and Downstream Valve Diagram

Changing Valve Position On Alicat Small Valve Mass Flow And Pressure Controllers
http://www.alicat.com/support/instructional-videos/
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PC3 AND PCR3 SERIES PRESSURE CONTROLLERS:

The PC3 and PCR3 Series pressure controller is designed to change the 
flow to allow the control of pressure at some point away from the body of 
the controller. 

This is most helpful when it is necessary to mount pneumatic components 
such as valves, fittings or flow meters that introduce significant pressure 
drop between pressure controller body and the point where pressure 
control is necessary. 

To accomplish this, the PC3 has an external sensing port to which the pressure 
at the location where pressure is to be controlled is piped back to the pressure 
sensor in the controller.

P1

P3

P3 P3 P3

P3

P3P2

Nozzle Under Test

Flow Meter (Pressure Drop)PC3 Series Pressure ControllerPC3-Series Pressure Controller         Flow Meter (Pressure Drop)

Nozzle Under Test

P1 P2

P3 P3

P3

Typical PC3 Application
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DIFFERENTIAL PRESSURE GAUGES:

The differential pressure gauge is designed to 
measure a pressure ratio between two points in 
the line. There are a variety of applications for 
this device. 

One of the most common is to measure the 
difference in pressure across some sort of 
element that changes resistance to flow over 
time, such as a filter, or one that changes area 
with time as would happen with orifice testing. 

The gauge has two sensing ports which are piped 
to the upstream and downstream sides of the 
pressure drop of interest in the system. 

These two ports run either to two separate 
pressure sensors or for low differential pressures – they may be run to the two 
legs of a single differential pressure sensor. The higher (upstream) pressure is 
applied to the left port and the lower (downstream) pressure is applied to the 
right port.

P1

P2

Differential Pressure Gauge Application
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DIFFERENTIAL PRESSURE CONTROLLERS:

The differential pressure controller is designed to change the flow to allow the 
control of a pressure ratio between two points in the line. There are a variety of 
applications for this device. 

One of the most common is to control the difference in pressure across some 
sort of element that changes resistance to flow over time, such as a filter 
or one that changes area with time as would happen with orifice testing. To 
accomplish differential pressure control, the controller has two sensing ports 
which are piped to the upstream and downstream sides of the pressure drop in 
the system. 

These two ports run either to two separate pressure sensors or for low 
differential pressures – they may be run to the two legs of a single differential 
pressure sensor. The controller itself changes the flow to the two sensing ports 
until the difference between the two pressures matches the set-point.

P2P1

P2P1 P2P1

Differential Pressure Controller Application
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PCD-SERIES DUAL VALVE PRESSURE CONTROLLER OPERATION
Alicat Scientific PCD-Series Closed Volume Pressure Controllers incorporate a 
digital pressure gauge with dual control valves and circuitry. The integrated PID 
loop measures the pressure, compares it with the set-point, and adjusts either 
the Inlet or Exhaust valve accordingly in excess of two thousand times per second. 
It is most common to have a .050 inch diameter orifice in the inlet valve, and 
a .050 inch diameter exhaust valve. The response time of the system will 
depend on the size of the volume being controlled and the feed pressure. The 
controllers are intended for use with clean, non-corrosive gases only. 
They are designed with a feed port, a process port, and an exhaust port. This 
allows the controllers to raise and lower the pressure of a closed system within 
the operating range of the controller without wasting gas under constant 
pressure conditions.
Plumbing
Connect your PCD into your process via the 1/8” NPT port on the front of the 
unit. This is the “Process” port. 
Connect a supply pressure greater than the full scale pressure control range of 
the device, not to exceed 145 psig, to the inlet 1/8” NPT port on the left side 
device. This is the “Inlet” port. 
The 1/8” NPT “Exhaust” port, located on the right side of the device can vent to 
atmosphere if the application is suitable, or to a collection network if necessary. 
The pressure at the exhaust port should be at atmospheric pressure or below to 
allow the controller to be used over its full scale range. 
If desired, there are two 8-32 mounting holes located on the bottom of the unit 
as shown in the dimensional drawing on page 52. 
Connect your PCD to power and output lines as detailed on pages 9 - 12.

Supply Pressure

Closed Volume

Decrease Pressure

Exhaust

Increase Pressure

Typical PCD Plumbing Diagram
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RS-232 / RS-485 OUTPUT AND INPUT
Configuring HyperTerminal®:

1. Open your HyperTerminal® RS-232 / RS-485 terminal program (installed under 
the “Accessories” menu on all Microsoft Windows® operating systems).

2. Select “Properties” from the file menu.
3. Click on the “Configure” button under the “Connect To” tab. Be sure the 

program is set for: 19,200 baud (or matches the baud rate selected in the 
RS-232 / RS-485 communications menu on the meter) and an 8-N-1-None 
(8 Data Bits, No Parity, 1 Stop Bit, and no Flow Control) protocol.

4. Under the “Settings” tab, make sure the Terminal Emulation is set to ANSI 
or Auto Detect.

5. Click on the “ASCII Setup” button and be sure the “Send Line Ends with Line 
Feeds” box is not checked and the “Echo Typed Characters Locally” box 
and the “Append Line Feeds to Incoming Lines” boxes are checked. Those 
settings not mentioned here are normally okay in the default position.

6. Save the settings, close HyperTerminal® and reopen it.
Streaming Mode (RS-485 units do not have a streaming mode)
In the default Polling Mode, the screen should be blank except the blinking cursor. 
In order to get the data streaming to the screen, hit the “Enter” key several times 
to clear any extraneous information. Type “*@=@” followed by “Enter” (or using 
the RS-232 / RS-485 communication select menu, select @ as identifier and exit 
the screen). If data still does not appear, check all the connections and COM port 
assignments.
Streaming Mode – Advanced 
The streaming data rate is controlled by register 91. The recommended default rate 
of data provision is once every 50 milliseconds and this is suitable for most purposes. 
If a slower or faster streaming data rate is desired, register 91 can be changed to a 
value from 1 millisecond to 65535 milliseconds, or slightly over once every minute. 
Below approximately 40 milliseconds, data provision will be dependent upon 
how many parameters are selected. Fewer data parameters can be streamed 
more quickly than more. It is left to the user to balance streaming speed with 
number of parameters streamed. 
To read register 91, type “*r91” followed by “Enter”. 
To modify register 91, type “*w91=X”, where X is a positive integer from 1 to 
65535, followed by “Enter”. 
To return to the recommended factory default streaming speed, type “*w91= 50”.
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Tareing via RS-232 / RS-485 (Gauges only):

Tareing (or zeroing) the pressure gauge provides it with a reference point for 
zero pressure. This is a very simple but important step in obtaining accurate 
measurements. It is good practice to “zero” the pressure gauge each time it is 
powered up. If the pressure reading varies significantly from zero after an initial 
tare, give the unit a minute or so to warm up and re-zero it. 

Zeroing the unit while there is any pressure will directly affect the accuracy 
by providing a false zero point. If in doubt about whether the pressure is zero, 
remove it from the line and open both ports to atmosphere before entering the 
Tare command. 

If the unit reads a significant negative value when removed from the line 
and open, it is a good indication that it was given a false zero. To send a Tare 
command via RS-232 / RS-485, enter the following strings:

In Polling Mode:  Address$$P<Enter>        (e.g. B$$P<Enter>)
Sending a Set-point via RS-232 / RS-485: To send a set-point via RS-232 / RS-485, 
“Serial” must be selected under the “Input” list in the control set up mode. 
Method 1:  Set-point may be set in floating point in serial communication using 
serial command (UnitID)SX.YZ 

Example:  AS4.54 results in Unit ID A changing set-point to 4.54.  
Method 2: Type in a number between 0 and 65535 (2% over range), where 64000 
denotes full-scale flow rate, and hit “Enter”. 

The set-point column and pressure rates should change accordingly. If they do 
not, try hitting “Enter” a couple of times and repeating your command. The 
formula for performing a linear interpolation is as follows:

 Value = (Desired Set-point X 64000) / Full Scale Pressure Range

For example, if your device is a 50 psig full-scale unit and you wish to apply a 
set-point of 12.5 psig you would enter the following value:

  16000 = (12.5 psig X 64000) / Full Scale Pressure Range

If the controller is in polling mode as described in Changing from Streaming 
Mode to Polling Mode, the set-point must be preceded by the address of the 
controller. For example, if your controller has been given an address of D, the 
set-point above would be sent by typing:

 D16000 followed by “Enter”
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To adjust the Proportional and Differential (P&D) terms via RS-232 / RS-485 
(PC and PCR-Series only):

Type *@=A followed by “Enter” to stop the streaming mode of information.

To adjust the “P” or proportional term of the PID controller, type *R21 followed 
by “Enter”.

The computer will respond by reading the current value for register 21 between 
0-65535. It is good practice to write this value down so you can return to the 
factory settings if necessary. Enter the value you wish to try by writing the new 
value to register 21. For example, if you wished to try a “P” term of 220, you 
would type *W21=220 followed by “Enter” where the bold number denotes the 
new value.

The computer will respond to the new value by confirming that 21=220. To 
see the effect of the change you may now poll the unit by typing A followed 
by “Enter”. This does an instantaneous poll and returns the values once. You 
may type A “Enter” as many times as you like. Alternately, you could resume 
streaming mode by typing *@=@ followed by “Enter”. Repeat step 3 to remove 
the unit from the streaming mode.

To adjust the “D” or proportional term of the PID controller, type *R22 followed 
by “Enter”.

The computer will respond by reading the current value for register 22 between 
0-65535. It is good practice to write this value down so you can return to the 
factory settings if necessary. Enter the value you wish to try by writing the new 
value to register 22. For example, if you wished to try a “D” term of 25, you 
would type *W22=25 followed by “Enter” where the bold number denotes the 
new value. 

The computer will respond to the new value by confirming that 22=25. To 
see the effect of the change you may now poll the unit by typing A followed 
by “Enter”. This does an instantaneous poll and returns the values once. You 
may type A “Enter” as many times as you like. Alternately you could resume 
streaming mode by typing *@=@ followed by “Enter”. Repeat. 

You may test your settings for a step change by changing the set-point. To do 
this type A32000 (A is the default single unit address, if you have multiple 
addressed units on your RS-232 / RS-485 line the letter preceding the value 
would change accordingly.) followed by “Enter” to give the unit a ½ full scale 
set-point. Monitor the unit’s response to the step change to ensure it is 
satisfactory for your needs. Recall that the “P” term controls how quickly the 
unit goes from one set-point to the next, and the “D” term controls how quickly 
the signal begins to “decelerate” as it approaches the new set-point (controls 
the overshoot).
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Changing From Streaming to Polling Mode: 

When the meter is in the Streaming Mode (RS-485 units do not have a 
streaming mode), the screen is updated approximately 10-60 times per second 
(depending on the amount of data on each line) so that the user sees the data 
essentially in real time. It is sometimes desirable, and necessary when using 
more than one unit on a single RS-232 line, to be able to poll the unit.

In Polling Mode the unit measures the flow normally, but only sends a line of 
data when it is “polled”. Each unit can be given its own unique identifier or 
address. Unless otherwise specified each unit is shipped with a default address 
of capital A. Other valid addresses are B thru Z.

Once you have established communication with the unit and have a stream of 
information filling your screen:

1. Type *@=A followed by “Enter” (or using the RS-232 / RS-485 
communication select menu, select A as identifier and exit the screen) to 
stop the streaming mode of information. Note that the flow of information 
will not stop while you are typing and you will not be able to read what you 
have typed. Also, the unit does not accept a backspace or delete in the line 
so it must be typed correctly. If in doubt, simply hit enter and start again. If 
the unit does not get exactly what it is expecting, it will ignore it. If the line 
has been typed correctly, the data will stop.

2. You may now poll the unit by typing A followed by “Enter”. This does an 
instantaneous poll of unit A and returns the values once. You may type A 
“Enter” as many times as you like. Alternately you could resume streaming 
mode by typing *@=@ followed by “Enter”. Repeat step 1 to remove the 
unit from the streaming mode.

3. To assign the unit a new address, type *@=New Address, e.g. *@=B. Care 
should be taken not to assign an address to a unit if more than one unit 
is on the RS-232 / RS-485 line as all of the addresses will be reassigned. 
Instead, each should be individually attached to the RS-232 / RS-485 line, 
given an address, and taken off. After each unit has been given a unique 
address, they can all be put back on the same line and polled individually.
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Collecting Data:

The RS-232 / RS-485 output updates to the screen many times per second. 
Very short-term events can be captured simply by disconnecting (there are 
two telephone symbol icons at the top of the HyperTerminal® screen for 
disconnecting and connecting) immediately after the event in question. The 
scroll bar can be driven up to the event and all of the data associated with 
the event can be selected, copied, and pasted into Microsoft® Excel® or other 
spreadsheet program as described below.

For longer term data, it is useful to capture the data in a text file. With the 
desired data streaming to the screen, select “Capture Text” from the Transfer 
Menu. Type in the path and file name you wish to use. Push the start button. 
When the data collection period is complete, simply select “Capture Text” from 
the Transfer Menu and select “Stop” from the sub-menu that appears.

Data that is selected and copied, either directly from HyperTerminal® or from 
a text file can be pasted directly into Excel®. When the data is pasted it will all 
be in the selected column. Select “Text to Columns...” under the Data menu in 
Excel® and a Text to Columns Wizard (dialog box) will appear. Make sure that 
“Fixed Width” is selected under Original Data Type in the first dialog box and 
click “Next”. In the second dialog box, set the column widths as desired, but 
the default is usually acceptable. Click on “Next” again.  In the third dialog box, 
make sure the column data format is set to “General”, and click “Finish”. This 
separates the data into columns for manipulation and removes symbols such 
as the plus signs from the numbers. Once the data is in this format, it can be 
graphed or manipulated as desired.

For extended term data capture see: “Sending a Simple Script to 
HyperTerminal®” on page 41.
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Data Format:

The data stream on the screen represents the pressure parameters of the main 
mode in the units shown on the display. For P-Series Pressure Gauges, there is 
a single column of data. This column represents the measured pressure in the 
units specified at time of order and shown on the display.

+4.123
+4.123
+4.123
+4.123
+4.124
+4.125

P-Series Pressure Gauge Data Format

For PC-Series Controllers, there are 2 columns of data representing pressure and 
set-point. The first column is pressure (normally in  psig), the second column is 
the set-point (in the units specified at time of order and shown on the display).

+014.70  014.70
+014.70  014.70
+014.70  014.70
+014.70  014.70
+014.70  014.70
+014.70  014.70

PC-Series Vacuum and Pressure Controller Data Format
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Sending a Simple Script File to HyperTerminal®

It is sometimes desirable to capture data for an extended period of time. 
Standard streaming mode information is useful for short term events, however, 
when capturing data for an extended period of time, the amount of data 
and thus the file size can become too large very quickly. Without any special 
programming skills, you can use HyperTerminal® and a text editing program 
such as Microsoft® Word® to capture text at defined intervals.

1. Open your text editing program, MS Word for example.

2. Set the cap lock on so that you are typing in capital letters.

3. Beginning at the top of the page, type A<Enter> repeatedly. If you’re using 
MS Word, you can tell how many lines you have by the line count at the bottom 
of the screen. The number of lines will correspond to the total number of times 
the flow device will be polled, and thus the total number of lines of data it will 
produce.
For example: A

 A
 A
 A
 A
 A
will get a total of six lines of data from the flow meter, but you can 
enter as many as you like.

The time between each line will be set in HyperTerminal.
4. When you have as many lines as you wish, go to the File menu and select 
save. In the save dialog box, enter a path and file name as desired and in the 
“Save as Type” box, select the plain text (.txt) option. It is important that it be 
saved as a generic text file for HyperTerminal to work with it.

5. Click Save.

6. A file conversion box will appear. In the “End Lines With” drop down box, 
select CR Only. Everything else can be left as default.

7. Click O.K.

8. You have now created a “script” file to send to HyperTerminal. Close the file 
and exit the text editing program.

9. Open HyperTerminal and establish communication with your flow device as 
outlined in the manual.

10. Set the flow device to Polling Mode as described in the manual. Each time 
you type A<Enter>, the meter should return one line of data to the screen.

11. Go to the File menu in HyperTerminal and select “Properties”.

12. Select the “Settings” tab.
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13. Click on the “ASCII Setup” button.

14. The “Line Delay” box is defaulted to 0 milliseconds. This is where you will 
tell the program how often to read a line from the script file you’ve created. 
1000 milliseconds is one second, so if you want a line of data every 30 seconds, 
you would enter 30000 into the box. If you want a line every 5 minutes, you 
would enter 300000 into the box.

15. When you have entered the value you want, click on OK and OK in the 
Properties dialog box.

16. Go the Transfer menu and select “Send Text File…” (NOT Send File…).

17. Browse and select the text “script” file you created.

18. Click Open.

19. The program will begin “executing” your script file, reading one line at 
a time with the line delay you specified and the flow device will respond by 
sending one line of data for each poll it receives, when it receives it.
You can also capture the data to another file as described in the manual 
under “Collecting Data”. You will be simultaneously sending it a script file and 
capturing the output to a separate file for analysis.
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TROUBLESHOOTING
Display does not come on or is weak.
Check power and ground connections and supply voltage. Please reference the 
technical specifications (pages 52-67) to assure you have the proper power for 
your model.

Pressure reading is approximately fixed either near zero or near full scale 
regardless of actual line pressure.
Differential pressure sensor may be damaged. A common cause of this problem 
is instantaneous application of high-pressure gas as from a snap acting solenoid 
valve upstream of the meter. If you suspect that your pressure sensor is 
damaged please discontinue use of the controller and contact Alicat.

Displayed pressure is flashing and message POV is displayed:
Our pressure gauges and controllers display an error message (POV = pressure 
overrange) when a the pressure exceeds the range of the sensors in the device. 
When any item flashes on the display, the pressure measurement is not accurate. 
Reducing the pressure to within specified limits will return the unit to normal 
operation and accuracy. If the unit does not return to normal contact Alicat.

My controller does not respond to the set-point.
Check that your set-point signal is present and supplied to the correct pin and 
that the correct set-point source is selected under the SETPT SOURCE list in the 
control set up display (page 25). Also check that the unit is properly grounded. 

After installation, there is no pressure.
Alicat Scientific PC-Series Controllers incorporate normally closed valves and 
require a set-point to operate. Check that your set-point signal is present and 
supplied to the correct pin and that the correct input is selected under the 
SETPT SOURCE list in the control set up display (page 25). Also check that the 
unit is properly grounded.

The pressure lags below the set-point.
Be sure there is enough pressure available. If either the set-point signal line and/
or the output signal line is relatively long, it may be necessary to provide heavier 
wires (especially ground wiring) to negate voltage drops due to line wire length. 
An inappropriate PID tuning can also cause this symptom if the D term is too large 
relative to the P term. See pages 28 and 29 for more information on PID tuning.

Controller is slow to react to a set-point change or imparts an oscillation to the flow.
An inappropriate PID tuning can cause these symptoms. Use at conditions 
considerably different than those at which the device was originally set up 
can necessitate a re-tuning of the PID loop. See pages 28 and 29 for more 
information on PID tuning. Note: The larger the volume pressured, the longer it 
takes to change the pressure in that volume.
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The output signal is lower than the reading at the display.
This can occur if the output signal is measured some distance from the gauge/
controller as voltage drops in the wires increase with distance. Using heavier 
gauge wires, especially in the ground wire, can reduce this effect.

My controller oscillates wildly and/or exhibits very different reactions to the set-
point than I expect.
Conditions considerably different than those at which the device was originally 
set up can necessitate a re-tuning of the PID loop. See pages 28 and 29  for 
more information on PID tuning.

RS-232 / RS-485 Serial Communications is not responding.
Check that your gauge is powered and connected properly. Be sure that the 
port on the computer to which the gauge is connected is active. Confirm that 
the port settings are correct per the RS-232 / RS-485 instructions in this manual 
(Check the RS-232 / RS-485 communications select screen for current gauge 
readings). Close HyperTerminal® and reopen it. Reboot your PC. 
See pages 11, 12 and 34 for more information on RS-232 / RS-485 signals and 
communications.

Slower response than specified.
P-Series Gauges and PC-Series Controllers feature an RS-232 / RS-485 
programmable Geometric Running Average (GRA). Depending on the full scale 
range of the gauge, it may have the GRA set to enhance the stability/readability 
of the display, which would result in slower perceived response time. Please see 
“Pressure Averaging” on page 19.

Jumps to zero at low pressure.
P-Series Gauges and PC-Series Controllers feature an RS-232 / RS-485 
programmable zero deadband. The factory setting is usually 0.5% of full scale. 
This can be adjusted between NONE and 3.2% of full scale. See page 19.
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MAINTENANCE AND RECALIBRATION
General: P, PC, PCR and PCD-Series Pressure Gauges and Controllers require 
minimal maintenance. They have no moving parts. The single most important thing 
that affects the life and accuracy of these devices is the quality of the gas being 
measured. The instruments are designed to measure CLEAN, DRY, NON-CORROSIVE 
gases. If your application requires an aggressive or corrosive gas, please consider 
Alicat’s  PS, PCS, PCRS and PCDS Series instruments (see page 61).
Recalibration: The recommended period for recalibration is once every year. A 
label located on the back of the controller lists the most recent calibration date. 
The controller should be returned to the factory for recalibration within one 
year from the listed date. Before calling to schedule a recalibration, please note 
the serial number on the back of the meter. The Serial Number, Model Number, 
and Date of Manufacture are also available on the Model Info display (page 21).
Cleaning: P, PC, PCR and PCD-Series Pressure Gauges and Controllers  require 
no periodic cleaning. If necessary, the outside of the controller can be cleaned 
with a soft dry cloth. Avoid excess moisture or solvents.
For repair, recalibration or recycling of this product, contact:

Alicat Scientific, Inc.
7641 N Business Park Drive

Tucson, Arizona 85743
USA

Ph. 520-290-6060
Fax 520-290-0109

email: info@alicat.com
Web site: www.alicat.com

Pressure Conversion Table
psi 1.00 = 51.7150 mmHg
psi 1.00 = 2.0360 inHg
psi 1.00 = 27.7080 inH20
psi 1.00 = 68.9480 mbar
psi 100.00 = 6.8046 atm
psi 1.00 = 51.7150 torr
psi 1.00 = 6.8948 kPa

mmHg 100.00 = 3.9370 inHg
mmHg 100 = 1.9337 psi

inHg 100 = 49.1159 psi
inH2O 100 = 3.6091 psi
mbar 100 = 1.4504 psi

atm 1 = 14.6959 psi
torr 100 = 1.9337 psi
kPa 100 = 14.5037 psi

inHg 1 = 25.4000 mmHg
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Alicat Portable Meters and Gauges
Alicat Rechargeable Flow Meters and Pressure Gauges use a Li-Ion 3.7V cell located in the top 
secti on of the device. The Li-Ion cell must not be removed.
Normal batt ery life of a fully-charged cell is 18 hours with a monochrome display or 
5 hours with a TFT color display, when the backlight is set to 10. Dimming the backlight 
will increase batt ery life.
The batt ery can be charged through either the micro-USB port or the mini-DIN connector. 
When the device is connected to external power it will functi on normally while the batt ery 
is charging. Note: If the batt ery has no charge, a charge ti me of one minute will be required 
before the unit can be turned on. Charge rates will be fastest through the micro-USB port 
using the included power supply or equivalent. The device will charge fastest when it is 
turned off . 
Recharge Time: 3.5 hours with 2A USB supply. The micro-USB port is for charging purposes only.
The green/red indicator LED on top of the device will light up green to indicate that the 
unit is charging. The green LED will turn off  when the batt ery is charged and the power 
switch is turned to “I” for ON. 
The indicator LED fl ashes red when the device has about 1 hour of batt ery life remaining. The 
LED will fl ash red at a faster rate when the device has about 15 minutes of batt ery life remaining. 
It is highly recommended that the device be charged immediately. When the batt ery charge runs 
out, the display contrast will turn to 0 and device performance is no longer guaranteed.

Output signals from the meter are passed through the mini-DIN connector on top 
of the device. Rechargeable batt ery units do not support 0-10V analog output. 
Receiver resistance must be below 250Ω.

Turn the power switch on top of the device to “O” for OFF when it is not in use.
Warning: If the device is left  ON unti l the batt ery can no longer power it, the 
charge indicator will fall out of sync with the actual charge. The device can be 
re-synced by fully charging the batt ery once.

A Batt ery Charge Indicator appears below Tare on the display:

CAUTION! Do not operate or store the de�ice outside o� the -10° 
to +50°C temperature range. I� interna� sensors detect that the 
temperature is outside o� this range, the disp�a� contrast wi�� turn to 0 
and the meter’s per�ormance is no �onger guaranteed. 

The sa�e charging temperature range is 0° to +45°C. I� interna� sensors detect 
temperatures outside o� this range, the �atter� wi�� not charge.

#C
+21.50

+0.000
CCM MENU

TARE VPSIA
+13.60

+0.000
SCCM

95 – 100%

80 – 95%

50 – 80%

20 – 50%

5 – 20%

0 – 5%

TOP VIEW OF DEVICE

Green = Charging
Flashing Red = Low Battery

+5 Vdc
Charge Only

1 2

3 4 5

6 7 8 I  
 O

On / Off 
I / O
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Opti on: Remote Electronics for High Line or Gas Temperatures

Some applicati ons involve operati ng 
temperatures outside the standard Alicat 
device specifi cati ons. A soluti on using 
remote electronics is available. (This opti on is 
not applicable for liquid devices.)

The fl ow body’s components are minimized 
to only the required sensors. The fl ow data is 
sent to the microprocessor electronics up to 
6 feet away from the sensor package. 

Relocati ng the sensiti ve electronics allows 
for installati on of the fl ow body in ambient 
temperatures as high as 85° Celsius with gas temperatures under 100°Celsius. 

In these applicati ons we recommend our custom gauge calibrati on at a 
gas temperature of up to 70°Celsius. This will reduce zero shift  errors that 
occur when actual gas fl ow temperatures deviate substanti ally from the gas 
calibrati on temperature. 

This confi gurati on is also used in integrati ons that require a compact fl ow 
package at the installati on point.

Opti on: Remote Panel Display 

Our Remote Display opti on off ers the fl exibility of using 
Alicat’s display with units that are embedded inside 
processes or instrument enclosures. 

The Remote Display retains all of the same features as our 
standard display.

The Remote Display is ideal for:

●  OEMs Remote Panel Mounti ng ●  Embedded Systems

●  Gas Panels   ● Fuel Cell Test Stati ons

●  Leak Detecti on Systems  ●  Arti fi cial Environments
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Accessory: BB9 Multi -Drop Box

The BB9 Multi -Drop Box makes it convenient to wire 
multi ple fl ow and/or pressure devices to a single RS-232 or 
RS-485 port. Now available with a USB interface!

The Multi -Drop Box has nine 8 pin Mini-DIN ports available. 
The ports are to be used with a standard double ended 8 pin 
Mini-DIN (DC-62) style cable going from the box to each fl ow 
or pressure device. 

A single DB9 D-SUB type connector (COM PORT) connects, using the included 
cable, to the serial connector on a PC or laptop. 

All of the fl ow and/or pressure devices are powered via a terminal block on the 
front of the box. 

If more than nine devices will be required, additi onal Multi -Drop Boxes can be 
daisy chained together with a double ended 8 pin Mini-DIN cable plugged into 
any receptacle on both boxes.

BB9 Power Supply for Large Valve Controllers: The PS24VHC (Power Supply 
24Vdc High Current) is a 6.5Amp 24Vdc power supply designed for running 
multi ple large controllers on a BB9. 

The 6.5Amp power supply can run as many as 8 large valve controllers, which 
makes it ideal for the BB9 and multi ple large valve (or small valve / large valve 
combinati on) controllers on a BB9.

BB-9 Multi-Drop 
BoxØ .156 Thru 4 Places

1.75

Ø .340 Thru 2 PL

3.46

6.75 1.55

5.06

BB9 Multi-Drop Box

Ø .156 Thru 4 Places

1.75

Ø .340 Thru 2 PL

Ø .175 Thru 2 PL

3.46

6.75 1.55

5.06

6.75

7.56
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Accessory: Flow Vision™ SC Software
Flow Vision™ SC is an intuitive software interface to help your test 
cycles run smoother and shorten your engineering time! 

Flow Vision™ SC lets you connect to and communicate with multiple Alicat 
units simultaneously. Now you can view virtual displays, control tabs, charts 
and data lines from every connected Alicat device on the same screen.

Flow Vision™ SC supports all RS-232 and RS-485 Serial communication 
functions, including: gas selection, tareing, set-point control, valve tuning 
and flow averaging.
Session Saving: Save and reload your configuration data with confidence. 
Script Building: Create scripts to adjust a controller’s set-point value at 
variable specified time intervals.
Charting: Chart as many parameters as you want off as many devices as you 
want, with color coding, zooming, and printing functionality.
Alarms: Create software alarms that will notify you of given parameter conditions.
Data Capture & Logging: Capture and log data to either a .csv file or a .txt file. 
Improved Data Logging and Data Log File Splitting for easy to manage data.

Accessory: Flow Vision™ MX Software
Alicat’s New Flow Vision™ MX software gives you an easy way to do  
GAS BLENDING using Alicat Mass Flow Controllers and your own PC. 

Flow Vision™ MX software is a simple way to connect up to six Alicat 
mass flow controllers and create your own gas mix concentrations.

Using our inexpensive BB9-USB and a single USB connection you can: 

• Create your own gas blends 
• Adjust flow rates 
• Save your specific blend formulas.

All the controllers can be powered through the BB9-USB with a single 
power supply.

Just connect your unique gases to each controller, select the gas type either 
locally on the controller or through Flow Vision™ MX, manifold the flow 
outputs and create your gas mix.
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Accessories
Part Number Description

FLOWVISIONSC Flow Vision™ SC software for interface with all Alicat instruments

FLOWVISIONMX Flow Vision™ MX software for gas blending

BB9 9 position Multi-Drop Box

BB9-I 9 position Multi-Drop Box, Industrial connectors

PVPS24U Universal 100-240 VAC to 24 Volt DC Power Supply Adapter

PS24VHC High current power supply for BB9 use with Large Valve Controllers

PCASE Industrial carry and storage case for portable meters/gauges

DC-61 8 Pin Male Mini-DIN connector cable, single ended, 6 foot length

DC-251 8 Pin Male Mini-DIN connector cable, single ended, 25 foot length

DC-301 8 Pin Male Mini-DIN connector cable, single ended, 30 foot length

DC-501 8 Pin Male Mini-DIN connector cable, single ended, 50 foot length

DC-751 8 Pin Male Mini-DIN connector cable, single ended, 75 foot length

DC-6RT 8 Pin Male Right Angle Mini-DIN Cable, single ended, 6 foot length
DC-62 8 Pin Male Mini-DIN connector cable, double ended, 6 foot length
DC-252 8 Pin Male Mini-DIN connector cable, double ended, 25 foot length
DC-502 8 Pin Male Mini-DIN connector cable, double ended, 50 foot length

DC-602 8 Pin Male Mini-DIN connector cable, double ended, 60 foot length

MD8DB9 8 Pin Male Mini-DIN to DB9 Female Adapter, 6 foot length

DBC-251 DB15 cable, single ended, 25 foot length

510199 DB9 cable, double-ended female, 3 meter length

IC10 Industrial cable, 6 Pin, single ended, 10 foot length

IC10-18G 18 gauge industrial cable, 6 Pin, single ended, 10 foot length

IC20 Industrial cable, 6 Pin, single ended, 20 foot length

IC24-18G 18 gauge industrial cable, 6 Pin, single ended, 24 foot length

IC50 Industrial cable, 6 Pin, single ended, 50 foot length

IC-102 Industrial cable, 6 pin double ended, 10 foot length

USB-RS232 RS-232 to USB Converter
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MNPT to Compression Fittings
10-32 - 1/8” SS-200-1-0157
10-32 - 1/4” SS-400-1-0256
1/8” - 1/8” SS-200-1-2
1/8” - 1/4” SS-400-1-2
1/8” - 3/8” SS-600-1-2
1/8” - 1/2” SS-810-1-2
1/8” - 3mm SS-3M0-1-2
1/8” - 4mm SS-4M0-1-2
1/8” - 6mm SS-6M0-1-2
1/8” - 8mm SS-8M0-1-2

1/8” - 12mm SS-12M0-1-2
1/4” - 1/8” SS-200-1-4
1/4” - 1/4” SS-400-1-4
1/4” - 3/8” SS-600-1-4
1/4” - 1/2” SS-810-1-4
1/4” - 3mm SS-3M0-1-4
1/4” - 4mm SS-4M0-1-4
1/4” - 6mm SS-6M0-1-4
1/4” - 8mm SS-8M0-1-4

1/4” - 12mm SS-12M0-1-4
1/2” - 1/8” SS-200-1-8
1/2” - 1/4” SS-400-1-8
1/2” - 3/8” SS-600-1-8
1/2” - 1/2” SS-810-1-8
1/2” - 3/4” SS-1210-1-8
1/2” - 6mm SS-6M0-1-8
1/2” - 8mm SS-8M0-1-8

1/2” - 12mm SS-12M0-1-8
1/2” - 16mm SS-16M0-1-8
3/4” - 1/4” SS-400-1-12
3/4” - 1/2” SS-810-1-12
3/4” - 3/4” SS-1210-1-12

3/4” - 12mm SS-12M0-1-12
3/4” - 16mm SS-16M0-1-12

Filters & Elements FNPT-MNPT
10-32 5μ 510053

10-32 20μ 510054
1/8” 20μ ILF-1/8-20
1/4” 40μ ILF-1/4-40
1/2” 40μ ILF-1/2-40*
3/4” 40μ ILF-3/4-40*

20μ element ILFE20
40μ element ILFE40
40μ element ILFE40L*

Filters & Elements FNPT-FNPT*
10-32 5μ CF-303-20-316

*requires MNPT to MNPT coupler to 
interface with Alicat flow bodies

10-32 Male UNF to 1/8 FNPT Adapter

410133

Male M5 (10-32) Buna-N O-ring face seal 
to 1/8”Female NPT

Accessories
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Technical Data for P-Series Pressure Gauges
Standard Specifications (Contact Alicat for available options.)

Performance P-Series Gauges
Full scale pressure < 2” H2O Accuracy Consult Factory

Full scale pressure ≥ 2” H2O  
Standard Accuracy ± 0.25%

Full scale pressure ≥ 2” H2O 
High Accuracy Option ± 0.125%

Repeatability ± 0.08% Full Scale
Zero Shift and Span Shift 0.02% Full Scale / ºCelsius

Operating Range / Turndown Ratio 0.5% to 100% Full Scale / 200:1 Turndown
Excess Pressure 128% FS Measurable

Burst Pressure 3 X Full Scale

Typical Response Time1 5 ms (Adjustable)
Warm-up Time < 1 Second

1. Volumes, feed pressures, exhaust pressures and line sizing will determine the limits of response times.

Operating Conditions P-Series Gauges
Gas Compatibility Compatible with all non-corrosive gases1

Operating Temperature -10 to +50 ºCelsius
Common Mode Pressure

(Differential Pressure Units Only) 200 psig

Mounting Attitude Sensitivity None
Ingress Protection IP40

Wetted Materials 302 & 303 Stainless Steel, Viton®. Silicone RTV, Silicon, Glass. 
If your application demands a different material, please contact Alicat.

1. For aggressive gases, please see our PS-Series pressure Gauges. For use with water or other liquids please 
contact Alicat

Communication / Power P-Series Gauges
Monochrome LCD or Color TFT Display 

with integrated touchpad Displays Pressure

Digital Output Signal1 Options RS-232 Serial / RS-485 Serial / PROFIBUS3 
Analog Output Signal2 Options 0-5 Vdc / 1-5 Vdc / 0-10 Vdc / 4-20 mA  

Optional Secondary Analog Output Signal2 0-5 Vdc / 1-5 Vdc / 0-10 Vdc / 4-20 mA 
Electrical Connection Options 8 Pin Mini-DIN / 9-pin D-sub (DB9) / 15-pin D-sub (DB15) / 6 pin locking

Supply Voltage 7-30 Vdc  (15-30 Vdc for 4-20 mA outputs)
Supply Current 0.040 Amp

1. The Digital Output Signal communicates  Pressure 
2. The Analog Output Signal and Optional Secondary Analog Output Signal communicate Pressure
3. If selecting PROFIBUS, no analog signal is available. PROFIBUS units do not have the display. See PROFIBUS 

specifications for PROFIBUS supply voltages and currents. (www.alicat.com/profibus)

Mechanical Specifications
Pressure Product Mechanical Dimensions Process Connections1

P-Series Gauges 4.1”H x 2.4”W x 1.1”D 1/8” NPT Female
1. Compatible with Beswick®, Swagelok® tube, Parker®, face seal, push connect and compression adapter fittings. VCR and 
SAE connections upon request.

Select One Unit of Measure when Ordering
PSIA inHG Atm

PSIG inH2O Torr

mmHG mBar kPa

Standard Available Ranges
P-Series Gauges
-15 psig to 0 psig

2 inH2OD 2 inH2OG
4 inH2OD 4 inH2OG

1 psid 1 psig
5 psid 5 psig

15 psid 15 psig 15 psia
30 psid 30 psig 30 psia
100 psid 100 psig 100 psia
150 psid 300 psig 300 psia

500 psig 500 psia

Other ranges available. Please contact Alicat.
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


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  
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









 







  








  














P-Series:
All standard ranges

P-Series:
Differential Pressure
All standard ranges
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Technical Data for PC, PC3, PCR, and PCR3 Single Valve Pressure Controllers
Standard Specifications (Contact Alicat for available options.)

Performance PC & PC3 Controllers PCR & PCR3 Controllers
Full scale pressure < 2” H2O Accuracy Consult Factory

Full scale pressure ≥ 2” H2O Standard Accuracy ± 0.25%
Full scale pressure ≥ 2” H2O 

High Accuracy Option ± 0.125%

Repeatability ± 0.08% Full Scale
Zero Shift and Span Shift 0.02% Full Scale / ºCelsius

Operating Range / Turndown Ratio 0.5% to 100% Full Scale / 200:1 Turndown
Excess Pressure 102.4% FS Controllable

Burst Pressure 3 X Full Scale

Typical Response Time1 100 ms (Adjustable)
Warm-up Time < 1 Second

1. Volumes, feed pressures, exhaust pressures and line sizing will determine the limits of response times.

Operating Conditions PC & PC3 Controllers PCR & PCR3 Controllers
Gas Compatibility Compatible with all non-corrosive gases1

Operating Temperature -10 to +50 ºCelsius
Common Mode Pressure

(Differential Pressure Units 
Only)

150 psig

Mounting Attitude Sensitivity None
Valve Type Normally Closed

Ingress Protection IP40

Wetted Materials
400 Stainless Steel, 302 & 303 Stainless Steel, Viton®. Silicone RTV, Silicon, Glass.
PC & PC3 Only Add: Brass
If your application demands a different material, please contact Alicat.

1. For aggressive gases, please see our PCS and PCRS-Series pressure controllers. For use with water or other 
liquids please contact Alicat

Communication / Power PC & PC3 Controllers PCR & PCR3 Controllers
Monochrome LCD or Color TFT Display 

with integrated touchpad Displays Pressure

Digital Output Signal1 Options RS-232 Serial / RS-485 Serial / PROFIBUS3 
Analog Output Signal2 Options 0-5 Vdc / 1-5 Vdc / 0-10 Vdc / 4-20 mA  

Optional Secondary Analog Output Signal2 0-5 Vdc / 1-5 Vdc / 0-10 Vdc / 4-20 mA 
Electrical Connection Options 8 Pin Mini-DIN / 9-pin D-sub (DB9) / 15-pin D-sub (DB15) / 6 pin locking

Supply Voltage 12-30 Vdc  (15-30 Vdc for 4-20 mA outputs) 24-30 Vdc
Supply Current 0.250 Amp 0.750 Amp

1. The Digital Output Signal communicates  Pressure 
2. The Analog Output Signal and Optional Secondary Analog Output Signal communicate Pressure
3. If selecting PROFIBUS, no analog signal is available. PROFIBUS units do not have the display. See 

PROFIBUS specifications for PROFIBUS supply voltages and currents. (www.alicat.com/profibus)

Mechanical Specifications
Pressure Product Mechanical Dimensions Process Connections1

PC & PC3 Controllers 4.1”H x 3.6”W x 1.1”D 1/8” NPT Female

PCR & PCR3 Controllers 5.5”H x 2.9”W x 5.5”D 3/4” NPT Female
1. Compatible with Beswick®, Swagelok® tube, Parker®, face seal, push connect and compression adapter fittings. VCR and 
SAE connections upon request.

Select One Unit of Measure when Ordering
PSIA inHG Atm

PSIG inH2O Torr

mmHG mBar kPa

Standard Available Ranges
PC, PC3, PCR & PCR3 Controllers

-15 psig to 0 psig
2 inH2OD 2 inH2OG
4 inH2OD 4 inH2OG

1 psid 1 psig
5 psid 5 psig
15 psid 15 psig 15 psia
30 psid 30 psig 30 psia
100 psid 100 psig 100 psia
150 psid 300 psig 300 psia

500 psig 500 psia
Other ranges available. Please contact Alicat.
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
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


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







 











 





































PC-Series:
All standard ranges

PC-Series:
Differential Pressure
All standard ranges
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


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






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
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
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






 


 







 

PC3-Series:
All standard ranges

PCR3-Series:
All standard ranges
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







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




 



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


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







PCR-Series:
Most standard ranges

PCR-Series:
Differential Pressure 5 inH2O
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Technical Data for PCD & PCRD Dual Valve Pressure Controllers

Mechanical Specifications

Standard Specifications (Contact Alicat for available options.)
Performance PCD Controllers PCRD Controllers

Full scale pressure < 2” H2O Accuracy Consult Factory
Full scale pressure ≥ 2” H2O Standard Accuracy ± 0.25%

Full scale pressure ≥ 2” H2O 
High Accuracy Option ± 0.125%

Repeatability ± 0.08% Full Scale
Zero Shift and Span Shift 0.02% Full Scale / ºCelsius

Operating Range / Turndown Ratio 0.5% to 100% Full Scale / 200:1 Turndown
Excess Pressure 102.4% FS Controllable

Burst Pressure 3 X Full Scale

Typical Response Time1 100 ms (Adjustable)
Warm-up Time < 1 Second

1. Volumes, feed pressures, exhaust pressures and line sizing will determine the limits of response times.

Operating Conditions PCD Controllers PCRD Controllers
Gas Compatibility Compatible with all non-corrosive gases1

Operating Temperature -10 to +50 ºCelsius
Common Mode Pressure

(Differential Pressure Units Only) 150 psig

Mounting Attitude Sensitivity None Mount with valve cylinder vertical & upright
Valve Type Normally Closed

Ingress Protection IP40

Wetted Materials 302 & 303 Stainless Steel, Viton®, Silicone RTV, Brass, 400 Series Stainless Steel, 
Silicon, Glass. If your application demands a different material, please contact Alicat.

1. For aggressive gases, please see our PCS and PCRS-Series pressure controllers. For use with water or other 
liquids please contact Alicat

Communication / Power PCD Controllers PCRD Controllers
Monochrome LCD or Color TFT Display 

with integrated touchpad Displays Pressure

Digital Output Signal1 Options RS-232 Serial / RS-485 Serial / PROFIBUS3 
Analog Output Signal2 Options 0-5 Vdc / 1-5 Vdc / 0-10 Vdc / 4-20 mA  

Optional Secondary Analog Output Signal2 0-5 Vdc / 1-5 Vdc / 0-10 Vdc / 4-20 mA 
Electrical Connection Options 8 Pin Mini-DIN / 9-pin D-sub (DB9) / 15-pin D-sub (DB15) / 6 pin locking

Supply Voltage 12-30 Vdc  (15-30 Vdc for 4-20 mA outputs) 24-30 Vdc
Supply Current 0.250 Amp 0.750 Amp

1. The Digital Output Signal communicates  Pressure 
2. The Analog Output Signal and Optional Secondary Analog Output Signal communicate Pressure
3. If selecting PROFIBUS, no analog signal is available. PROFIBUS units do not have the display. See 

PROFIBUS specifications for PROFIBUS supply voltages and currents. (www.alicat.com/profibus)

Dual Valve Pressure Controllers Mechanical Dimensions Process Connections1 

PCD All Standard Ranges 4.1”H x 4.8”W x 1.1”D 1/8” NPT Female

PCRD All Standard Ranges 5.5”H x 10.6”W x 2.3”D 3/4” NPT Female

1. Compatible with Swagelok® tube, Parker®, face seal, push connect and compression adapter fittings.  VCR and 
SAE connections upon request.

Select One Unit of Measure when Ordering
PSIA inHG Atm

PSIG inH2O Torr

mmHG mBar kPa

Standard Available Ranges
PCD and PCRD Controllers

-15 psig to 0 psig
2 inH2OD 2 inH2OG
4 inH2OD 4 inH2OG

1 psid 1 psig
5 psid 5 psig
15 psid 15 psig 15 psia
30 psid 30 psig 30 psia
100 psid 100 psig 100 psia
150 psid 300 psig 300 psia

500 psig 500 psia
Other ranges available. Please contact Alicat.
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PCD-Series:
All standard ranges

PCD-Series:
Differential Pressure
All standard ranges
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PCRD-Series:
All standard ranges



 
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
























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Technical Data for Alicat PS Series Pressure and Vacuum Gauges
Alicat PS instruments are built for use with aggressive gases. For the most part these 
instruments maintain the specifications of equivalently ranged P-Series devices. 
In addition to all non-corrosive gases, PS Gauges are configured to operate with 
the following aggressive gases. 
PS Gauge Aggressive Gas Compatibility List :

NO   Nitric Oxide to 100%
NF3   Nitrogen Triflouride to 100%
NH3   Ammonia to 100%
NO2   Nitrogen Dioxide to 100%
Cl2   Chlorine  to 100%
H2S   Hydrogen Sulfide to 100%
SO2   Sulfur Dioxide to 100%
Propylene to 100%

In addition the following gases are available upon request:
Refrigerant gases to 100% (refrigerant gases my require custom seals, 
consult Alicat)

If your application requires another gas or gas mixture, please contact Alicat. We 
will do our best to accommodate your request.

Technical Data for PCS, PCRS, PCDS and PCRDS Pressure and Vacuum Controllers
Alicat PCS, PCRS, PCDS and PCRDS instruments are built for use with aggressive 
gases. For the most part these instruments maintain the specifications of 
equivalently ranged PC, PCR , PCD and PCRD Series devices. 
In addition to all non-corrosive gases, PCS, PCRS, PCDS and PCRDS controllers are 
configured to operate with the following aggressive gases.
 PCS, PCRS, PCDS and PCRDS Controller Aggressive Gas Compatibility List :

NO   Nitric Oxide to 100%
NF3   Nitrogen Triflouride to 100%
NH3   Ammonia to 100%
NO2   Nitrogen Dioxide to 100%
H2S   Hydrogen Sulfide to 100% (22°C and under)
Propylene to 100%

In addition, the following gases are available upon request:
Refrigerant gases to 100% (refrigerant gases my require custom seals, 
consult Alicat)
Other gases to 1000 ppm in an inert carrier

If your application requires another gas or gas mixture, please contact Alicat. We 
will do our best to accommodate your request.

USING PS, PCS, and PCRS INSTRUMENTS with FLUIDS
PS, PCS and PCRS devices may be used with chemically compatible liquids. Please 
contact Alicat for technical assistance if your application involves fluids.
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Technical Data for PS-Series Pressure Gauges
Standard Specifications (Contact Alicat for available options.)

Performance PS-Series Gauges
Full scale pressure Standard Accuracy ± 0.25%

Full scale pressure High Accuracy Option ± 0.125%
Repeatability ± 0.08% Full Scale

Zero Shift and Span Shift 0.02% Full Scale / ºCelsius
Operating Range / Turndown Ratio 0.5% to 100% Full Scale / 200:1 Turndown

Excess Pressure 128% FS Measurable
Burst Pressure 3 X Full Scale

Typical Response Time1 5 ms (Adjustable)
Warm-up Time < 1 Second

1. Volumes, feed pressures, exhaust pressures and line sizing will determine the limits of response times.

Operating Conditions PS-Series Gauges
Gas Compatibility Compatible with all non-corrosive gases and select aggressive gases1

Operating Temperature -10 to +50 ºCelsius
Common Mode Pressure

(Differential Pressure Units Only) 200 psig

Mounting Attitude Sensitivity None
Ingress Protection IP40

Wetted Materials
316LSS, FFKM (Kalrez) standard; Viton, EPDM, Buna, Neoprene as 
needed for some gases.
 If your application demands a different material, please contact Alicat.

1. In addition to all non-corrosive gases, PS Gauges are configured to operate with the following aggressive 
gases: Ammonia, Chlorine, Hydrogen Sulfide, Nitric Oxide, Nitrogen Dioxide, Nitrogen Triflouride, Propylene, 
Sulfur Dioxide. The following gases are available upon request: Refrigerant gases to 100% (Refrigerant gases 
my require custom seals, consult Alicat.) If your application requires another gas or gas mixture, please contact 
Alicat. For use with water or other liquids please contact Alicat.

Communication / Power PS-Series Gauges
Monochrome LCD or Color TFT Display 

with integrated touchpad Displays Pressure

Digital Output Signal1 Options RS-232 Serial / RS-485 Serial / PROFIBUS3 
Analog Output Signal2 Options 0-5 Vdc / 1-5 Vdc / 0-10 Vdc / 4-20 mA  

Optional Secondary Analog Output Signal2 0-5 Vdc / 1-5 Vdc / 0-10 Vdc / 4-20 mA 
Electrical Connection Options 8 Pin Mini-DIN / 9-pin D-sub (DB9) / 15-pin D-sub (DB15) / 6 pin locking

Supply Voltage 7-30 Vdc  (15-30 Vdc for 4-20 mA outputs)
Supply Current 0.040 Amp

1. The Digital Output Signal communicates  Pressure 
2. The Analog Output Signal and Optional Secondary Analog Output Signal communicate Pressure
3. If selecting PROFIBUS, no analog signal is available. PROFIBUS units do not have the display. See PROFIBUS 

specifications for PROFIBUS supply voltages and currents. (www.alicat.com/profibus)

Mechanical Specifications
Pressure Product Mechanical Dimensions Process Connections1

PS Gauges 4.1”H x 2.4”W x 1.1”D 1/8” NPT Female
1. Compatible with Beswick®, Swagelok® tube, Parker®, face seal, push connect and compression adapter fittings. VCR and 
SAE connections upon request.

Select One Unit of Measure when Ordering
PSIA inHG Atm

PSIG inH2O Torr

mmHG mBar kPa

Standard Available Ranges
PS-Series Gauges
-15 psig to 0 psig

1 psid 1 psig
5 psid 5 psig

15 psid 15 psig 15 psia
30 psid 30 psig 30 psia
100 psid 100 psig 100 psia
150 psid 300 psig 300 psia

500 psig 500 psia
Other ranges available. Please contact Alicat.
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  



PS-Series:
All standard ranges 
to 500 psig
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Technical Data for PCS and PCRS Single Valve Pressure Controllers
Standard Specifications (Contact Alicat for available options.)

Performance PCS Controllers PCRS Controllers
Full scale pressure Standard Accuracy ± 0.25%

Full scale pressure High Accuracy Option ± 0.125%
Repeatability ± 0.08% Full Scale

Zero Shift and Span Shift 0.02% Full Scale / ºCelsius
Operating Range / Turndown Ratio 0.5% to 100% Full Scale / 200:1 Turndown

Excess Pressure 102.4% FS Controllable
Burst Pressure 3 X Full Scale

Typical Response Time1 100 ms (Adjustable)
Warm-up Time < 1 Second

1. Volumes, feed pressures, exhaust pressures and line sizing will determine the limits of response times.

Operating Conditions PCS Controllers PCRS Controllers
Gas Compatibility Compatible with all non-corrosive gases and select aggressive gases1

Operating Temperature -10 to +50 ºCelsius
Common Mode Pressure

(Differential Pressure Units Only) 150 psig

Mounting Attitude Sensitivity None
Valve Type Normally Closed

Ingress Protection IP40

Wetted Materials
303SS, 430FRSS, 316LSS, FFKM (Kalrez) standard; Viton, EPDM, Buna, 
Neoprene as needed for some gases.
If your application demands a different material, please contact Alicat.

1. In addition to all non-corrosive gases, PC & PCR controllers are configured to operate with the following 
aggressive gases: Ammonia, Hydrogen Sulfide, Nitric Oxide, Nitrogen Dioxide, Nitrogen Triflouride, Propylene. 
The following gases are available upon request: Refrigerant gases to 100% (Refrigerant gases my require 
custom seals, consult Alicat.) Other gases to 1000 ppm in an inert carrier. If your application requires another gas 
or gas mixture, please contact Alicat. PCS and PCRS devices may be used with chemically compatible liquids. 
Please contact Alicat for technical assistance if your application involves fluids.

Communication / Power PCS Controllers PCRS Controllers
Monochrome LCD or Color TFT Display 

with integrated touchpad Displays Pressure

Digital Output Signal1 Options RS-232 Serial / RS-485 Serial / PROFIBUS3 
Analog Output Signal2 Options 0-5 Vdc / 1-5 Vdc / 0-10 Vdc / 4-20 mA  

Optional Secondary Analog Output Signal2 0-5 Vdc / 1-5 Vdc / 0-10 Vdc / 4-20 mA 
Electrical Connection Options 8 Pin Mini-DIN / 9-pin D-sub (DB9) / 15-pin D-sub (DB15) / 6 pin locking

Supply Voltage 12-30 Vdc  (15-30 Vdc for 4-20 mA outputs) 24-30 Vdc
Supply Current 0.250 Amp 0.750 Amp

1. The Digital Output Signal communicates  Pressure 
2. The Analog Output Signal and Optional Secondary Analog Output Signal communicate Pressure
3. If selecting PROFIBUS, no analog signal is available. PROFIBUS units do not have the display. See 

PROFIBUS specifications for PROFIBUS supply voltages and currents. (www.alicat.com/profibus)

Mechanical Specifications
Pressure Product Mechanical Dimensions Process Connections1

PCS Controllers 4.1”H x 3.6”W x 1.1”D 1/8” NPT Female

PCRS Controllers 5.7”H x 2.9”W x 5.5”D 3/4” NPT Female
1. Compatible with Beswick®, Swagelok® tube, Parker®, face seal, push connect and compression adapter fittings. VCR and 
SAE connections upon request.

Select One Unit of Measure when Ordering
PSIA inHG Atm

PSIG inH2O Torr

mmHG mBar kPa

Standard Available Ranges
PCS & PCRS Controllers

-15 psig to 0 psig

1 psid 1 psig

5 psid 5 psig

15 psid 15 psig 15 psia
30 psid 30 psig 30 psia
100 psid 100 psig 100 psia

300 psig 300 psia

500 psig 500 psia
0ther ranges available. Please contact Alicat.
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PCRS-Series:
Most standard ranges


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













 
 

PCS-Series:
All standard ranges 
to 500 psig
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Technical Data for PCDS & PCRDS Dual Valve Pressure Controllers

Mechanical Specifications

Standard Specifications (Contact Alicat for available options.)
Performance PCDS Controllers PCRDS Controllers

Full scale pressure Standard Accuracy ± 0.25%
Full scale pressure High Accuracy Option ± 0.125%

Repeatability ± 0.08% Full Scale
Zero Shift and Span Shift 0.02% Full Scale / ºCelsius

Operating Range / Turndown Ratio 0.5% to 100% Full Scale / 200:1 Turndown
Excess Pressure 102.4% FS Controllable

Burst Pressure 3 X Full Scale

Typical Response Time1 100 ms (Adjustable)
Warm-up Time < 1 Second

1. Volumes, feed pressures, exhaust pressures and line sizing will determine the limits of response times.

Operating Conditions PCDS Controllers PCRDS Controllers
Gas Compatibility Compatible with all non-corrosive gases1

Operating Temperature -10 to +50 ºCelsius
Common Mode Pressure

(Differential Pressure Units Only) 150 psig

Mounting Attitude Sensitivity None Mount with valve cylinder vertical & upright
Valve Type Normally Closed

Ingress Protection IP40

Wetted Materials
316LSS, 303SS, 430FRSS, FFKM (Kalrez) standard; Viton, EPDM, Buna, 
Neoprene as needed for some gases.   If your application demands a different 
material, please contact Alicat.

1. In addition to all non-corrosive gases, PC & PCR controllers are configured to operate with the following 
aggressive gases: Ammonia, Hydrogen Sulfide, Nitric Oxide, Nitrogen Dioxide, Nitrogen Triflouride, Propylene. 
The following gases are available upon request: Refrigerant gases to 100% (Refrigerant gases my require 
custom seals, consult Alicat.) Other gases to 1000 ppm in an inert carrier. If your application requires another gas 
or gas mixture, please contact Alicat. PCS and PCRS devices may be used with chemically compatible liquids. 
Please contact Alicat for technical assistance if your application involves fluids.

Communication / Power PCDS Controllers PCRDS Controllers
Monochrome LCD or Color TFT Display 

with integrated touchpad Displays Pressure

Digital Output Signal1 Options RS-232 Serial / RS-485 Serial / PROFIBUS3 
Analog Output Signal2 Options 0-5 Vdc / 1-5 Vdc / 0-10 Vdc / 4-20 mA  

Optional Secondary Analog Output Signal2 0-5 Vdc / 1-5 Vdc / 0-10 Vdc / 4-20 mA 
Electrical Connection Options 8 Pin Mini-DIN / 9-pin D-sub (DB9) / 15-pin D-sub (DB15) / 6 pin locking

Supply Voltage 12-30 Vdc  (15-30 Vdc for 4-20 mA outputs) 24-30 Vdc
Supply Current 0.250 Amp 0.750 Amp

1. The Digital Output Signal communicates  Pressure 
2. The Analog Output Signal and Optional Secondary Analog Output Signal communicate Pressure
3. If selecting PROFIBUS, no analog signal is available. PROFIBUS units do not have the display. See 

PROFIBUS specifications for PROFIBUS supply voltages and currents. (www.alicat.com/profibus)

Dual Valve Pressure Controllers Mechanical Dimensions Process Connections1 

PCDS All Standard Ranges 4.1”H x 4.8”W x 1.1”D 1/8” NPT Female

PCRD All Standard Ranges 5.5”H x 10.6”W x 2.3”D 3/4” NPT Female

1. Compatible with Swagelok® tube, Parker®, face seal, push connect and compression adapter fittings.  VCR and 
SAE connections upon request.

Select One Unit of Measure when Ordering
PSIA inHG Atm

PSIG inH2O Torr

mmHG mBar kPa

Standard Available Ranges
PCDS and PCRDS Controllers

-15 psig to 0 psig
1 psid 1 psig
5 psid 5 psig
15 psid 15 psig 15 psia
30 psid 30 psig 30 psia
100 psid 100 psig 100 psia
150 psid 300 psig 300 psia

500 psig 500 psia
 Other ranges available. Please contact Alicat.
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PCRDS-Series:
Most standard ranges
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PCDS-Series:
Most standard ranges
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Specification Meter  or 
Gauge

Small Valve
Controller

Large Valve
Controller Description

Input /Output Signal Digital PROFIBUS DP

Electrical Connections DB9
Supply Voltage: 7 to 30 Vdc 12 to 30 Vdc 24 to 30 Vdc

Supply Current 80mA @ 12Vdc
65mA @ 24Vdc

295mA @ 12Vdc
280mA @ 24Vdc 780mA @ 24Vdc

Technical Data for PROFIBUS Meters, Gauges and Controllers

NOTICE: The following specifications are applicable to Alicat PROFIBUS enabled meters, 
gauges and controllers only. 
All other operating specifications are shown in the Technical Data page for standard Alicat 
instruments.
All standard device features and functions are available and operate in accordance with the 
standard Alicat Scientific device operating manual provided with the device.

Power and Signal Connections:
Connect to the device using two DB9 
connectors.
The female top connection is PROFIBUS. 
The male connection on the side is power and 
RS-232 or RS-485.
Pin out diagrams for all PROFIBUS enabled 
Alicat devices are shown:

PROFIBUS MC1SLPM shown to provide PROFIBUS connector dimensions only. Flow 
body and valve dimensions will vary with range. Please see Alicat’s device specifications for 
complete dimensions. 

PROFIBUS units do not have a display screen.

2 x 8-32 UNC ┬v  .350

.525

.35

4.264.08

3.76

3.59

1/8 NPT
Both Sides

1.05

.525

.35

2.225
.150 .125

.925

MC-1SLPM-PROFIBUS

1. NC
2. OPT GND
3. DP
4. RTS
5. DGD
6. VP
7. OPT 7 to 30VDC
8. DN
9. NC

5 1
9 6

TOP

1. NC
2. RS232RX
3. RS232TX
4. NC
5. GND
6. NC
7. 7 to 30VDC
8. GND
9. NC

1
6

5
9

SIDE
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Eight Pin Mini-DIN Connector Pin-Outs
If your Alicat Instrument was ordered with the standard Eight Pin Mini-DIN 

connection, please be sure to reference the following pin-out diagram.

Standard 8 Pin Mini-DIN Pin-Out



 







1 2

3 4 5

6 7 8

Pin Function Mini-DIN 
cable color

1 Inactive (or optional 4-20mA Primary Output Signal) Black

2 Static 5.12 Vdc [or optional Secondary Analog Output (4-20mA, 
5Vdc, 10Vdc) or Basic Alarm] Brown

3 Serial RS-232RX / RS-485(–) Input Signal (receive) Red

4 Meters/Gauges = Remote Tare (Ground to Tare)
Controllers = Analog Set-Point Input Orange

5 Serial RS-232TX  / RS-485(+) Output Signal (send) Yellow
6 0-5 Vdc (or optional 0-10 Vdc) Output Signal Green
7 Power In (as described above) Blue

8 Ground (common for power, digital communications, analog signals 
and alarms) Purple

Note: The above pin-out is applicable to all the flow meters and controllers with the 
Mini-DIN connector. The availability of different output signals depends on the options 
ordered. Optional configurations are noted on the unit’s calibration sheet.
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













       

 






 



520-290-6060 Ph.  520-290-0109 Fax


7641 N Business Park Dr.  Tucson, AZ 85743









































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The above pin-out is applicable to all the flow meters and controllers ordered with the 
industrial connector. The availability of different output signals depends on the flow 
meter options ordered.

The locking industrial connector is standard on all CSA/ATEX approved devices. 
RS-485 is not available on CSA/ATEX approved devices.

Locking Industrial Connector Pin-Outs
If your Alicat Instrument was ordered with a Six Pin Locking Industrial 
connection, please be sure to reference the following pin-out diagram.

Pin Function
1 Power In  ( + )
2 RS-232TX / RS-485(+)
3 RS-232RX / RS-485(-)
4 Meters/Gauges = Remote Tare (Ground to Tare)

Controllers = Analog Set-Point Input
5 Ground (common for power, communications and signals)
6 Signal Out (Voltage or Current as ordered)

Male Connector: Cable Female Connector: Device
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Pin Function
1 Not Connected (4-20mA analog output signal optional)

2 5.12 Vdc or (secondary analog output (4-20mA, 5Vdc, 10Vdc or 
alarm optional)

3 Serial RS-232RX or RS-485(-)

4 Analog Input Signal [4-20mA, 5Vdc, or 10Vdc] (short to ground 
for remote tare function on non-controllers)

5 Serial RS-232TX or RS-485(+)
6 0-5 Vdc Output Signal (or 0-10 Vdc optional) 
7 Power In (+Vdc)

8 Ground (common for power, digital communications, analog 
signals and alarms)

9 Ground (common for power, digital communications, analog 
signals and alarms)

Note: The above pin-out is applicable to all the flow meters and controllers 
with the DB9 connector. The availability of different output signals depends 
on the options ordered. Optional configurations are noted on the unit’s 
calibration sheet.

Do not connect RS-485 to RS-232 units or cables. Damage will 
occur! Check part number or contact factory to verify RS-485 
functionality.

Due to variance in cable manufacturing, please identify proper 
wiring/pins via continuity check & color when using blunt cut 
multi-strand cables.

Standard DB9 Pin-out
The following pin-out chart describes the safest and generally compatible 
arrangement when connecting a non-Alicat DB9 wire to a DB9 equipped Alicat. 
Not all features may be available between brands, but the common denominators 
are featured in our DB9 offerings, along with some options for customization.
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If your instrument was ordered with a DB9 connection, be sure to check the 
Calibration Label on the device and reference the appropriate pin-out diagram.
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Do not connect RS-485 to RS-232 units or cables. Damage will 
occur! Check part number or contact factory to verify RS-485 
functionality.

Due to variance in cable manufacturing, please identify proper 
wiring/pins via continuity check & color when using blunt cut 
multi-strand cables.

DB9A Pin-out
The following pin-out chart describes the safest and generally compatible 
arrangement when connecting a non-Alicat DB9 wire to a DB9A equipped Alicat. 
Not all features may be available between brands, but the common denominators 
are featured in our DB9N offerings, along with some options for customization.
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If your instrument was ordered with a DB9 connection, be sure to check the 
Calibration Label on the device and reference the appropriate pin-out diagram.

Pin Function
1 Not Connected 
2 0-5 Vdc Output Signal (or 0-10 Vdc optional)
3 Power In (+Vdc) 

4 Ground (common for power, digital communications, analog 
signals and alarms)

5 Serial RS-232TX or RS-485 (+) 

6 Analog Input Signal [4-20mA, 5Vdc, or 10Vdc] (short to ground 
for remote tare function on non-controllers)

7 Ground (common for power, digital communications, analog 
signals and alarms)

8 Ground (common for power, digital communications, analog 
signals and alarms)

9 Serial RS-232RX or RS-485 (-)
Note: The above pin-out is applicable to all the flow meters and controllers 
with the DB9A connector. The availability of different output signals 
depends on the options ordered. Optional configurations are noted on the 
unit’s calibration sheet.
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Do not connect RS-485 to RS-232 units or cables. Damage will 
occur! Check part number or contact factory to verify RS-485 
functionality.

Due to variance in cable manufacturing, please identify proper 
wiring/pins via continuity check & color when using blunt cut 
multi-strand cables.

DB9N Pin-out
The following pin-out chart describes the safest and generally compatible 
arrangement when connecting a non-Alicat DB9 wire to a DB9N equipped Alicat. 
Not all features may be available between brands, but the common denominators 
are featured in our DB9N offerings, along with some options for customization.
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Pin Function
1 Power In (+Vdc) 

2 Analog Input Signal [4-20mA, 5Vdc, or 10Vdc] (short to ground 
for remote tare function on non-controllers)

3 0-5 Vdc Output Signal (or 0-10 Vdc optional) 
4 Not Connected

5 Ground (common for power, digital communications, analog 
signals and alarms)

6 Ground (common for power, digital communications, analog 
signals and alarms)

7 Serial RS-232RX or RS-485 (-)
8 Serial RS-232TX or RS-485 (+)
9 Not Connected

Note: The above pin-out is applicable to all the flow meters and controllers 
with the DB9N connector. The availability of different output signals 
depends on the options ordered. Optional configurations are noted on the 
unit’s calibration sheet.

If your instrument was ordered with a DB9 connection, be sure to check the 
Calibration Label on the device and reference the appropriate pin-out diagram.
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Do not connect RS-485 to RS-232 units or cables. Damage will 
occur! Check part number or contact factory to verify RS-485 
functionality.

Due to variance in cable manufacturing, please identify proper 
wiring/pins via continuity check & color when using blunt cut 
multi-strand cables.

DB9R Pin-out
The following pin-out chart describes the safest and generally compatible 
arrangement when connecting a non-Alicat DB9 wire to a DB9R equipped Alicat. 
Not all features may be available between brands, but the common denominators 
are featured in our DB9R offerings, along with some options for customization.



7641 N Business Park Dr.  Tucson, AZ 85743

520-290-6060 Ph.  520-290-0109 Fax



7641 N Business Park Dr.  Tucson, AZ 85743

520-290-6060 Ph.  520-290-0109 Fax

Female Connector Front View

9 9

Male Connector Front View

6

1

6

1 5 5

If your instrument was ordered with a DB9 connection, be sure to check the 
Calibration Label on the device and reference the appropriate pin-out diagram.

Pin Function
1 Serial RS-232TX or RS-485 (+)
2 0-5 Vdc Output Signal (or 0-10 Vdc optional)

3 Analog Input Signal [4-20mA, 5Vdc, or 10Vdc] (short to ground 
for remote tare function on non-controllers) 

4 Ground (common for power, digital communications, analog 
signals and alarms)

5 Not Connected
6 Serial RS-232RX or RS-485 (-)   
7 Power In (+Vdc) 

8 Ground (common for power, digital communications, analog 
signals and alarms)

9 Ground (common for power, digital communications, analog 
signals and alarms)

Note: The above pin-out is applicable to all the flow meters and controllers 
with the DB9R connector. The availability of different output signals 
depends on the options ordered. Optional configurations are noted on the 
unit’s calibration sheet.
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Do not connect RS-485 to RS-232 units or cables. Damage will 
occur! Check part number or contact factory to verify RS-485 
functionality.

Due to variance in cable manufacturing, please identify proper 
wiring/pins via continuity check & color when using blunt cut 
multi-strand cables.

DB9T Pin-out
The following pin-out chart describes the safest and generally compatible 
arrangement when connecting a non-Alicat DB9 wire to a DB9T equipped Alicat. 
Not all features may be available between brands, but the common denominators 
are featured in our DB9T offerings, along with some options for customization.
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If your instrument was ordered with a DB9 connection, be sure to check the 
Calibration Label on the device and reference the appropriate pin-out diagram.

Pin Function
1 Serial RS-232TX or RS-485 (+) 
2 0-5 Vdc Output Signal (or 0-10 Vdc optional)
3 Power In (+Vdc) 

4 Ground (common for power, digital communications, analog 
signals and alarms)

5 Not Connected

6 Analog Input Signal [4-20mA, 5Vdc, or 10Vdc] (short to ground 
for remote tare function on non-controllers)

7 Ground (common for power, digital communications, analog 
signals and alarms)

8 Ground (common for power, digital communications, analog 
signals and alarms)

9 Serial RS-232RX or RS-485 (-)
Note: The above pin-out is applicable to all the flow meters and controllers 
with the DB9T connector. The availability of different output signals 
depends on the options ordered. Optional configurations are noted on the 
unit’s calibration sheet.
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Do not connect RS-485 to RS-232 units or cables. Damage will 
occur! Check part number or contact factory to verify RS-485 
functionality.

Due to variance in cable manufacturing, please identify proper 
wiring/pins via continuity check & color when using blunt cut 
multi-strand cables.

DB9U Pin-out
The following pin-out chart describes the safest and generally compatible 
arrangement when connecting a non-Alicat DB9 wire to a DB9U equipped Alicat. 
Not all features may be available between brands, but the common denominators 
are featured in our DB9U offerings, along with some options for customization.
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Pin Function
1 Serial RS-232RX or RS-485(-)
2 0-5 Vdc Output Signal (or 0-10 Vdc optional) 
3 Power In (+Vdc)

4 Ground (common for power, digital communications, analog 
signals and alarms)

5 Not Connected

6 Analog Input Signal [4-20mA, 5Vdc, or 10Vdc] (short to ground 
for remote tare function on non-controllers)

7 Ground (common for power, digital communications, analog 
signals and alarms)

8 Ground (common for power, digital communications, analog 
signals and alarms)

9 Serial RS-232TX or RS-485(+)
Note: The above pin-out is applicable to all the flow meters and controllers 
with the DB9U connector. The availability of different output signals 
depends on the options ordered. Optional configurations are noted on the 
unit’s calibration sheet.

If your instrument was ordered with a DB9 connection, be sure to check the 
Calibration Label on the device and reference the appropriate pin-out diagram.
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DB15 – Pin-Out Alicat Style

Pin Number Function
1 Ground
2 Primary Analog Signal Output
3 Ground
4 N/C
5 Power Supply (+Vdc)
6 N/C
7 N/C

8  Analog Tare (meters — when grounded)
Analog Set-Point Input (controllers)

9 Power Supply Common
10 Ground
11 Secondary Analog Signal Output / fi xed 5.12Vdc
12 N/C
13 RS-232 RX (receive) or RS-485 –
14 Ground
15 RS-232 TX (send) or RS-485 +

Check your device’s calibration certifi cate and user manual for the actual electrical input/
output requirements, as all instruments are custom confi gured to some extent.
NOTE: Pins 1, 3, 9, 10, and 14 are connected together inside of the device and are 
common grounding points.
N/C = Not Connected/Open (can be used for custom pin assignments – please consult factory).

The following pin-out chart describes the safest and generally compatible arrangement 
when connecting a non-Alicat DB15 wire to a DB15 equipped Alicat. Not all features may be 
available between brands, but the common denominators are featured in our DB15 offerings, 
along with some options for customization.

DB15 Pin-Outs
If your instrument was ordered with a DB15 connection, 
be sure to check the Calibration Label on the device and 

reference the appropriate pin-out diagram.

Male Connector Front View Female Connector Front View
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2 5
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Pin Number Function
1 Ground
2 Primary Analog Signal Output

3 Analog Tare (meters — when grounded)*
Analog Set-Point Input (controllers)*

4 Ground
5 Power Supply Common
6 Ground
7 Power Supply (+Vdc)
8 RS-232 Tx (send) / RS-485, A (-) [receive]
9 Ground
10 N/C
11 N/C
12 Secondary Analog Signal Output / fi xed 5.12Vdc*
13 N/C
14 N/C
15 RS-232 Rx (receive) / RS-485, A (+) [send]

Check your device’s calibration certifi cate and user manual for the actual electrical input/
output requirements, as all instruments are custom confi gured to some extent.
* Added to allow for full use of features on Alicat devices, may not be present on host wiring
NOTE: Pins 1, 4, 5, 6, and 9 are connected together inside of the device and are common 
grounding points.
N/C = Not Connected/Open (can be used for custom pin assignments – please consult factory).

DB15A – Pin-Out “Aalborg XFM” Style

The following pin-out chart describes the safest and generally compatible arrangement when 
connecting a non-Alicat DB15 wire to a DB15A equipped Alicat. Not all features may be 
available between brands, but the common denominators are featured in our DB15 offerings, 
along with some options for customization.

DB15 Pin-Outs
If your instrument was ordered with a DB15 connection, 
be sure to check the Calibration Label on the device and 

reference the appropriate pin-out diagram.

Male Connector Front View Female Connector Front View
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DB15B – Pin-Out “Brooks” Style

Pin Number Function
1 Ground
2 Primary Analog Signal Output
3 N/C
4 N/C
5 Power Supply (+Vdc)
6 N/C
7 N/C

8 Analog Tare (meters — when grounded)
Analog Set-Point Input (controllers)

9 Power Supply Common
10 Ground
11 Secondary Analog Signal Output / fi xed 5.12Vdc
12 N/C
13 N/C
14 RS-232 RX (receive) or RS-485 –
15 RS-232 TX (send) or RS-485 +

Check your device’s calibration certifi cate and user manual for the actual electrical input/
output requirements, as all instruments are custom confi gured to some extent.
NOTE: Pins 1, 9, and 10 are connected together inside of the device and are common 
grounding points.
N/C = Not Connected/Open (can be used for custom pin assignments – please consult factory).

The following pin-out chart describes the safest and generally compatible arrangement when 
connecting a non-Alicat DB15 wire to a DB15B equipped Alicat. Not all features may be 
available between brands, but the common denominators are featured in our DB15 offerings, 
along with some options for customization.

DB15 Pin-Outs
If your instrument was ordered with a DB15 connection, 
be sure to check the Calibration Label on the device and 

reference the appropriate pin-out diagram.
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DB15K – Pin-Out “MKS” Style

The following pin-out chart describes the safest and generally compatible arrangement when 
connecting a non-Alicat DB15 wire to a DB15K equipped Alicat. Not all features may be 
available between brands, but the common denominators are featured in our DB15 offerings, 
along with some options for customization.

DB15 Pin-Outs
If your instrument was ordered with a DB15 connection, 
be sure to check the Calibration Label on the device and 

reference the appropriate pin-out diagram.

Pin Number Function
1 N/C
2 Primary Analog Signal Output
3 N/C
4 N/C
5 Power Supply Common
6 N/C
7 Power Supply (+Vdc)

8 Analog Tare (meters — when grounded)
Analog Set-Point Input (controllers)

9 Secondary Analog Signal Output / fi xed 5.12Vdc *
10 N/C
11 Ground
12 Ground
13 RS-232 RX (receive) or RS-485 – *
14 RS-232 TX (send) or RS-485 + *
15 Ground

Check your device’s calibration certifi cate and user manual for the actual electrical input/
output requirements, as all instruments are custom confi gured to some extent.
NOTE: Pins 5, 11, 12 and 15 are connected together inside of the device and are common 
grounding points.
N/C = Not Connected/Open (can be used for custom pin assignments – please consult factory).
* Added to allow for full use of features on Alicat devices, may not be present on host wiring.

Male Connector Front View Female Connector Front View
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DB15H – Pin-Out “Hastings H” Style

Pin Number Function
1 N/C
2 RS-232 RX (receive) or RS-485 – *
3 N/C
4 N/C
5 Ground
6 Primary Analog Signal Output
7 Power Supply Common
8 N/C
9 N/C
10 Secondary Analog Signal Output / fi xed 5.12Vdc *
11 Power Supply (+Vdc) 
12 Ground
13 N/C

14 Analog Tare (meters — when grounded)
Analog Set-Point Input (controllers)

15 RS-232 TX (send) or RS-485 + *
Check your device’s calibration certifi cate and user manual for the actual electrical input/
output requirements, as all instruments are custom confi gured to some extent.
NOTE: Pins 5, 7 and 12 are connected together inside of the device and are common 
grounding points.
N/C = Not Connected/Open (can be used for custom pin assignments – please consult factory).
* Added to allow for full use of features on Alicat devices, may not be present on host wiring.

Male Connector Front View Female Connector Front View
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The following pin-out chart describes the safest and generally compatible arrangement when 
connecting a non-Alicat DB15 wire to a DB15H equipped Alicat. Not all features may be 
available between brands, but the common denominators are featured in our DB15 offerings, 
along with some options for customization.

DB15 Pin-Outs
If your instrument was ordered with a DB15 connection, 
be sure to check the Calibration Label on the device and 

reference the appropriate pin-out diagram.
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DB15S – Pin-Out “Sierra” Style

Pin Number Function
1 Ground
2 Primary Analog Signal Output 
3 N/C
4 N/C
5 Ground
6 N/C
7 N/C

8 Analog Tare (meters — when grounded)
Analog Set-Point Input (controllers)

9 Power Supply Common
10 Ground
11 Secondary Analog Signal Output / fi xed 5.12Vdc *
12 RS-232 RX (receive) or RS-485 – *
13 Power Supply (+Vdc) 
14 RS-232 TX (send) or RS-485 + *
15 Ground

Check your device’s calibration certifi cate and user manual for the actual electrical input/
output requirements, as all instruments are custom confi gured to some extent.
NOTE: Pins 1, 5, 9, 10 and 15 are connected together inside of the device and are common 
grounding points.
N/C = Not Connected/Open (can be used for custom pin assignments – please consult factory).
* Added to allow for full use of features on Alicat devices, may not be present on host wiring.

Male Connector Front View Female Connector Front View
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The following pin-out chart describes the safest and generally compatible arrangement when 
connecting a non-Alicat DB15 wire to a DB15S equipped Alicat. Not all features may be 
available between brands, but the common denominators are featured in our DB15 offerings, 
along with some options for customization.

DB15 Pin-Outs
If your instrument was ordered with a DB15 connection, 
be sure to check the Calibration Label on the device and 

reference the appropriate pin-out diagram.
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NOTES FOR USING PC-EXTSEN DEVICES
PC-EXTSEN units connect a Pressure Controller (with no internal pressure 
sensor) to an end-user supplied external pressure sensor. Designed mainly 
for the vacuum coating industry, the PC-EXTSEN marries the sensing ability 
of an existing capacitance manometer or ion gauge with a Alicat’s 16 Series 
electronics package and internal PID algorithm. This enables fast and precise 
control of extreme vacuum conditions in the coating chamber. 

The PC-EXTSEN receives a linear analog signal from the external sensor. This analog 
signal corresponds to a full scale range that is specified by the user at the time 
of order (and corresponds to the scale of the external sensor). The PC-EXTSEN 
interprets this analog signal as its sensed pressure. 

The PC-EXTSEN then utilizes its proportional control valve to control the flow 
of gas into the chamber, allowing for closed loop vacuum control based on the 
interpreted signal. Set-point control and PID tuning all happen through the 
instrument’s interface, via the buttons on the display, or a user selected analog 
interface (0-5V, 0-10V, or 4-20mA), or through a multidrop RS-232 interface. 

There are two base models of PC-EXTSEN controllers, the PC-EXTSEN-D, and the 
PC-EXTSEN-D-ISC. 

The PC-EXTSEN-D has an 8 pin Mini-DIN female electrical connector as its electrical 
connection to power, ground, signal input from the external sensor, RS-232 transmit 
and receive, as well as analog transmit and receive. The PC-EXTSEN-D also has a 
barrel plug electrical connection if you choose to power the device through a wall 
mounted AC adaptor, rather then wiring power to the 8 pin minidin connection. 

The PC-EXTSEN-D-ISC is identical to the PC-EXTSEN-D except it has an additional 
locking 6 pin industrial electrical connector which is intended for use as a dedicated 
connection to your external sensor, leaving the 8 pin Mini-DIN connection available 
to be used as a dedicated RS-232 or analog interface connection. 

Please refer to the appropriate sections of this operating manual for complete 
information regarding use and tuning of your PC-EXTSEN controller.

When using a PC-EXTSEN-D-ISC device, it is recommended that power 
and communications to the PC-EXTSEN-D-ISC device be wired through 
the 8 pin Mini-DIN connector and that the industrial connector is 
maintained as a dedicated connection to the external sensor.  

WHEN USING THE INDUSTRIAL CONNECTOR AS A DEDICATED 
CONNECTION TO THE SENSOR, DO NOT WIRE ANY SIGNAL INPUT INTO 
PIN 2 ON THE Mini-DIN CONNECTOR.
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PC-EXTSEN-D Pin-Outs
The following pin-out diagram is applicable to all standard PC-EXTSEN-D 
devices. If your device was ordered with custom pin-out requirements, please 
contact Alicat for assistance.

PC-EXTSEN-D Standard 8 Pin Mini-DIN Pin-Out

Pin Functi on Mini-DIN 
cable color

1 Inacti ve or 4-20mA Primary Output Signal Black
2 External Sensor Signal Input* Brown
3 RS-232 Input Signal Red
4 Analog Input Signal Orange
5 RS-232 Output Signal Yellow
6 0-5 Vdc (or 0-10 Vdc) Output Signal Green
7 Power In Blue
8 Ground (common for power, communicati ons and signals) Purple

*If you are using the PC-EXTSEN-D-ISC’s 6 pin locking connecti on to receive the 
external sensor input signal do not wire any signal into pin 2 of the Mini-DIN.



 







Pin 7 which is normally uti lized to provide power into the Alicat device can 
be used to provide power to your external sensor. Please make sure that 
the power you are providing to the device is compati ble with the power 
your sensor can accept before choosing to wire power in this manner.

CAUTION! Do not connect power to pins 1 through 6 as permanent 
damage can occur!

POWER AND SIGNAL CONNECTIONS
Power can be supplied to your controller through either the power jack or the 8 pin 
Mini-DIN connector. 
An AC to DC adapter which converts line AC power to DC voltage and current as 
specifi ed below is required to use the power jack. 
A 2.1mm, positi ve center, 12-30 Vdc AC/DC adapter rated for at least 250 mA is 
required to use the adapter jack in a PC-Series controller. 
A 2.1mm, positi ve center, 24-30 Vdc AC/DC adapter rated for at least 500 mA is 
required to use the adapter jack in a PCR-Series controller.
NOTE: 4-20mA analog output requires at least 15 Vdc.
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PC-EXTSEN-D-ISC Pin-Outs
The PC-EXTSEN-D-ISC is equipped with an additional Six Pin Locking connection, 
for use as a dedicated connection to your external sensor. 

This leaves the 8 pin Mini-DIN connection available to be used as a dedicated 
RS-232 or analog interface connection. 

Please be sure to reference the following pin-out diagram. The following pin-out 
diagram is applicable to all standard PC-EXTSEN-D-ISC devices. If your device was 
ordered with custom pin-out requirements, please contact Alicat for assistance.

Pin Function Cable Color
1 Power In  ( + ) Red
2 In-Active Blue
3 In-Active White
4 External Sensor Signal Input Green
5 Ground (common for power,

     communications and signals)
Black

6 In-Active Brown

PC-EXTSEN-D-ISC Standard 6 Pin Locking Connection Pin-Out

Pin 1 which is normally utilized to provide power into the Alicat device can 
be used to provide power to your external sensor. Please make sure that 
the power you are providing to the device is compatible with the power 
your sensor can accept before choosing to wire power in this manner.

When using a PC-EXTSEN-D-ISC device, it is recommended that power 
and communications to the PC-EXTSEN-D-ISC device be wired through 
the 8 pin connector and that the industrial connector is maintained as a 
dedicated connection to the external sensor.  

WHEN USING THE INDUSTRIAL CONNECTOR AS A DEDICATED 
CONNECTION TO THE SENSOR, DO NOT WIRE ANY SIGNAL INPUT INTO 
PIN 2 ON THE Mini-DIN CONNECTOR.

The 6 pin locking connection on the –ISC unit has only three active pins, 
power, ground and signal input from the external sensor.

PC-EXTSEN-D-ISC 

6 Pin Locking Connection

8 Pin Mini-DIN Connection End-user Supplied 
External Sensor
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Additional Information for Alicat CSA and ATEX Approved Devices
See the following page for Special Conditions regarding the use of these units!

EEx nA IIC T4 
Class I, Div. 2 Group A, B, C and D T4

24 Vdc, 0.800A max
Class I, Zone 2 AEx nA IIC T4

WARNINGS: 

EXPLOSION HAZARD – DO NOT DISCONNECT WHILE CIRCUIT IS 
LIVE UNLESS AREA IS KNOWN TO BE NON-HAZARDOUS.

EXPLOSION HAZARD – SUBSTITUTION OF COMPONENTS MAY 
IMPAIR SUITABILITY FOR CLASS I, DIVISION 2.

II 3 G
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All Alicat CSA / ATEX approved devices are equipped with a locking 6 pin industrial 
connector. The power and signal connections are shown below.

Clearance Requirements for 
Industrial Connector

Pin Function
1 Power In  ( + )
2 RS-232TX 
3 RS-232RX 
4 Remote Tare Meters (Ground to Tare)

Analog Set-Point Input (Controllers)
5 Ground (common for power, 

communications and signals)
6 Signal Out (Voltage or Current as 

ordered)
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USE of Alicat instruments  (M, MW, MS, MC, MCW, MCS, MCR, MCRW, MCRS, P, PS, PC, 
PCS, PCR and PCRS product families only) in Class 1 Division 2 applications.

CSA certifies the use of this product for general use as well as use in hazardous 
locations as defined by Class 1 Division 2 Group A, B, C and D T4. 
 CSA certification is indicated by the product label as shown below and 
not by the statements in this, or any accompanying documentation.

Special Conditions:
To comply with CSA certification the following information is included in the product literature:

•	 When equipment is properly labeled, it is suitable in Class I, Division 2, Group A, B, 
C and D, T4

o Tamb. -40°C to +50°C 
•	 Electrical Rating 24Vdc, 0.800A max
•	 Instruments shall be powered by a CSA certified, UL listed, Class II external power 

supply suitable for the application
•	 Instruments shall be housed in an enclosure with a minimum IP54 rating or location 

providing equivalent protection
•	 Instrument’s final approval shall be provided by the local authority having jurisdiction

EEx nA IIC T4 
Class I, Div. 2 Group A, B, C and D T4

24 Vdc, 0.800A max
Class I, Zone 2 AEx nA IIC T4

X – See manual for special conditions
WARNINGS: 

EXPLOSION HAZARD – DO NOT 
DISCONNECT WHILE CIRCUIT IS LIVE 
UNLESS AREA IS KNOWN TO BE NON-
HAZARDOUS.
EXPLOSION HAZARD – SUBSTITUTION 
OF COMPONENTS MAY IMPAIR 
SUITABILITY FOR CLASS I, DIVISION 2.

www.AlicatScientific.com

Alicat Scientific, Inc.
Tucson, AZ USA
Tel: 520-290-6060

II 3 G

USE of Alicat instruments (M, MW, MS, MC, MCW, MCS, MCR, MCRW, MCRS, P, PS, PC, 
PCS, PCR and PCRS product families only) in applications requiring ATEX Certification.
Properly labeled Alicat instruments comply to the following ATEX standard:

II 3 G EEx nA IIC T4 (-40°C ≤ Ta ≤ +50°C)
The examination certificate was issued by the CSA in accordance with 
accepted practices and procedures. This confirms compliance with the 
European ATEX Directive or Group II Category 3G equipment.

ATEX certification is indicated by the product label as shown above and not by the 
statements in this, or any accompanying documentation.
Special Conditions:

•	 Properly labeled equipment is only certified for use in ambient temperatures in the 
range of -40°C to +50°C only

•	 Electrical Rating 24Vdc, 0.800A max
•	 Instruments shall be powered by a CSA certified, UL listed, Class II external power 

supply suitable for the application
•	 Instruments shall be housed in an enclosure with a minimum IP54 rating or location 

providing equivalent protection
•	 Instrument’s final approval shall be provided by the local authority having jurisdiction
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Serial Number: ______________________
Model Number: _________________________
Notice: Alicat Scientific, Inc. reserves the right to make any changes and improvements to the products 
described in this manual at any time and without notice. This manual is copyrighted. This document may 
not, in whole or in part, be copied, reproduced, translated, or converted to any electronic medium or 
machine readable form, for commercial purposes, without prior written consent from the copyright holder.
Note: Although we provide assistance on Alicat Scientific products both personally and through our 
literature, it is the complete responsibility of the user to determine the suitability of any product to their 
application.

Limited Lifetime Warranty
Alicat Scientific, Inc. warrants to the original purchaser (hereinafter referred to as “Buyer”) that 
instruments manufactured by Alicat Scientific (hereinafter referred to as “Product”) shall be free from 
defects in materials and workmanship for the life of the Products.
Under this warranty, the Products will be repaired or replaced at manufacturer’s option, without charge for 
parts or labor when the Product is carried or shipped prepaid to the factory together with proof of purchase.
The foregoing shall constitute the exclusive and sole remedy in lieu of other remedies of the Buyer for 
any breach by Alicat Scientific of this warranty to the maximum extent permitted by law.
This warranty does not apply to any Product which has not been installed or used in accordance with 
the Product operation and installation specifications provided to Buyer verbally or in writing by Alicat 
Scientific for the proper and normal use of the Product.
Buyer agrees hereunder that Alicat reserves the right to void any warranty, written or implied, if upon 
Alicat’s examination of Product shall disclose to Alicat’s satisfaction that the Product failure was due 
solely, or in part, to accident, misuse, neglect, abuse, alteration, improper installation, unauthorized 
repair or improper testing by Buyer or agent of Buyer.
Alicat Scientific shall not be liable under any circumstances for indirect, special, consequential, or 
incidental damages in connection with, or arising out of, the sale, performance, or use of the Products 
covered by this warranty.
Alicat Scientific does not recommend, warrant or assume responsibility for the use of the Products in life 
support applications or systems.
Alicat’s warranties as herein above set forth shall not be enlarged, diminished or affected by, and no 
obligation or liability shall arise or grow out of Alicat’s rendering of technical advice in connection with 
Buyer’s order of the Products furnished hereunder.
If Product becomes obsolete, Alicat Scientific, at its own discretion, reserves the right to repair the 
Product with available replacement parts or upgrade the Product to a current, commercially available 
version of the original Product.  Should upgrading the Product be deemed necessary by Alicat, Buyer 
hereby agrees to pay an upgrade fee equal to seventy percent of the retail value of the replacement 
Product.  Alicat Scientific hereunder makes no claim that replacement Products will look, function or 
operate in the same or similar manner as the original product.
When a Product is returned to Alicat Scientific for recalibration this service is considered normal 
preventative maintenance.  Recalibration of Product shall not be treated as a warranty service unless 
recalibration of Product is required as the result of repairs to Product pursuant to this Warranty.  Failure 
of Buyer to send Product to Alicat Scientific for recalibration on a yearly basis after a period of 36 months 
from date of manufacture will remove any and all obligations regarding repair or replacement of Product 
as outlined by this Warranty to Buyer from Alicat Scientific.
This Warranty is in lieu of all other relevant warranties, expressed or implied, including the implied 
warranty of merchantability and the implied warranty of fitness for a particular purpose, and any warranty 
against infringement of any patent.
Continued use or possession of Products after expiration of the applicable warranty period stated above 
shall be conclusive evidence that the warranty is fulfilled to the full satisfaction of Buyer. 
Alicat makes no warranty as to experimental, non-standard or developmental Products.
Accessories purchased from Alicat are not covered by this warranty.

Conformity / Supplemental Information:
The product complies with the requirements of the Low Voltage Directive 2006/95/EC and the EMC Directive 
2004/108/EC and carries the CE Marking accordingly. Contact the manufacturer for more information.
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A

bsolute
Viscosity*

25°C

D
ensity **
25°C

14.696PSIA

C
om

pressibility
 25°C

14.696PSIA
20

75%
A

r / 25%
 C

O
2

C
-25

206.9763
1.6766

0.9987
21

90%
 A

r / 10%
 C

O
2

C
-10

218.6026
1.6509

0.9991
22

92%
 A

r / 8%
 C

O
2

C
-8

220.1352
1.6475

0.9992
23

98%
 A

r / 2%
 C

O
2

C
-2

224.7148
1.6373

0.9993
24

75%
 C

O
2 / 25%

 A
r

C
-75

168.2250
1.7634

0.9966
25

75%
 A

r / 25%
 H

e
H

E-75
231.6056

1.2660
0.9997

26
75%

 H
e / 25%

 A
r

H
E-25

234.6860
0.5308

1.0002

27
90%

 H
e / 7.5%

 A
r / 

2.5%
 C

O
2

 H
elistar®

 A
1025

A
1025

214.9760
0.3146

1.0003

28
90%

 A
r / 8%

 C
O

2 / 
2%

 O
2

Stargon®
 C

S
Star29

219.7934
1.6410

0.9992

29
95%

 A
r / 5%

 C
H

4
P-5

223.9106
1.5850

0.9993
*in m

icropoise (1 Poise = gram
 / (cm

) (sec))         **G
ram

s/Liter                                       
R

eference: N
IST R

EFPR
O

P 9 D
atabase

G
as V

iscosity, D
ensity and C

om
pressibility:


